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About This Guide

This guide describes how to use the Designer to create User Application components. It explains
how to work with the Provisioning view, the directory abstraction layer editor, the provisioning
request definition editor, the provisioning team editor, and the role catalog.

+ Chapter 1, “Introduction to the User Application Design Tools,” on page 15

+ Chapter 2, “Working with the Provisioning View,” on page 19

+ Chapter 3, “Configuring the Directory Abstraction Layer,” on page 51

+ Chapter 4, “Configuring Provisioning Request Definitions,” on page 91

+ Chapter 5, “Creating Forms for a Provisioning Request Definition,” on page 115

+ Chapter 6, “Creating the Workflow for a Provisioning Request Definition,” on page 183

+ Chapter 7, “Workflow Activity Reference,” on page 225

+ Chapter 8, “Working with Integration Activities,” on page 273

+ Chapter 9, “Working with ECMA Expressions,” on page 321

+ Chapter 10, “Configuring Provisioning Teams,” on page 371

+ Chapter 11, “Configuring Roles,” on page 379

+ Chapter 12, “Configuring Resources,” on page 409

+ Appendix A, “ECMAScript Core Reference,” on page 417

Audience

This guide is intended for designers responsible for creating and modifying User Application
components.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentation/feedback.html and enter your
comments there.

Additional Documentation

For documentation on other Identity Manager features, see the Identity Manager Documentation
Web site (http://www.novell.com/documentation/idm).

Documentation Conventions

In Novell® documentation, a greater-than symbol (>) is used to separate actions within a step and
items in a cross-reference path.

A trademark symbol (®, ™, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party
trademark.

About This Guide
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When a single pathname can be written with a backslash for some platforms or a forward slash for
other platforms, the pathname is presented with a backslash. Users of platforms that require a
forward slash, such as Linux* or UNIX*, should use forward slashes as required by your software.
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Introduction to the User
Application Design Tools

This section provides an overview of the tools available for designing and configuring the User
Application. Topics include:

+ Section 1.1, “About the Provisioning View,” on page 15

+ Section 1.2, “About the Directory Abstraction Layer Editor,” on page 16

+ Section 1.3, “About the Provisioning Request Definition Editor,” on page 16

+ Section 1.4, “About the ECMA Expression Builder,” on page 16

+ Section 1.5, “About the Provisioning Team Editor,” on page 17

+ Section 1.6, “About the Roles Catalog,” on page 17

+ Section 1.7, “Documenting a Project,” on page 17

IMPORTANT: The User Application is an application and not a framework. The areas within the
User Application that are supported to be modified are outlined within the product documentation.
Modifications to areas not outlined within the product documentation are not supported.

1.1 About the Provisioning View

The Provisioning view provides persistent access to Designer’s provisioning, roles, and compliance
features. Use the Provisioning view to perform the following actions on provisioning and roles
objects:

+ Access the editors that allow you to create and manipulate User Application components, such
as:

*

The directory abstraction layer editor.

*

The provisioning request definitions editor.

*

The provisioning editor.

*

The roles catalog.

Double-clicking an item from the Provisioning view opens the editor for that item.
+ Manipulate object definitions, such as:

*

Importing and exporting object definitions from the Identity Vault or the local file system.

*

Validating local object definitions.
+ Deploying object definitions to the Identity Vault.
+ Comparing the objects on the local file system with those in the Identity Vault.
+ Define the User Application driver’s supported and default locales, including:
+ Importing and exporting display labels and other User Application strings for localization.
+ Defining custom localization resource groups (used only for field localization).

Introduction to the User Application Design Tools
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1.2 About the Directory Abstraction Layer Editor

The directory abstraction layer editor allows you to define directory abstraction layer definitions.
Use the directory abstraction layer editor to modify the User Application’s behavior by:

*

Adding new entities (lIdentity Vault objects).

*

Defining the set of attributes for an entity.

*

Specifying the contents of lists.

*

Modeling relationships among entities.

*

Defining automatic lookups between entities.
+ Defining LDAP searches as Queries that you can run from request and approval forms.

1.3 About the Provisioning Request Definition
Editor

The provisioning request definition editor allows you to create custom provisioning request
definitions by using a rich set of Eclipse*-based design tools. Use the provisioning request
definition editor to:

+ Define the basic characteristics of the provisioning request.

+ Design the associated workflow.

+ Define the request and approval forms.

+ Configure the activities and flow paths.

1.4 About the ECMA Expression Builder

Designer incorporates an ECMASCcript interpreter and expression editor, which allows you create
script expressions that refer to and modify workflow data. For example, you can use scripting to:
+ Create new data items needed in a workflow under the flowdata element.
+ Perform basic string, date, math, relational, concatenation, and logical operations on data.
+ Call standard or custom Java* classes for more sophisticated data operations.
+ Use expressions for runtime control to:
+ Modify or override form field labels.
+ |Initialize form field data.
+ Customize e-mail addresses and content.
+ Set entitlement grant/revoke rights and parameters.

+ Evaluate any past activity data to conditionally follow a workflow path by using the
Condition Activity.

+ Write different log messages that are conditionally triggered by using a single Log
Activity.
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1.5 About the Provisioning Team Editor

The provisioning team editor allows you to define a set of users who can act as a team within the
User Application. The team definition determines who can manage provisioning requests and
approval tasks associated with this team. The team definition consists of a list of team managers,
team members, and team options. In addition, you can define the set of provisioning request objects
that the team can act on.

1.6 About the Roles Catalog

The Roles Catalog includes tools that let you define the contents of the Roles tab of the User
Application. The tools available through the roles catalog include:

+ Resource editor: Defines the set of available resources. Includes information about the
resource’s trustees, owners, approval workflow, and entitlements.

+ Role editor: Defines the set of available roles. Includes information about the role’s trustees,
owners, role containment hierarchy, and entitlements.

+ Separation of Duties editor: Defines the separation of duties constraints and how to handle
requests for exceptions to those constraints.

+ Role Configuration editor: Lets you modify the roles subsystem administrative settings.

The Roles Catalog also includes a menu option that enables you to import roles defined in a comma-
separated values (CSV) file.

1.7 Documenting a Project

Designer provides a document generator that helps you quickly generate customized documentation
for your Designer projects. You can define your own document style, but Designer ships with a
default provisioning style. The default provisioning style includes sections for the User Application.
The sections include:

Provisioning Locales

Lists the supported locales and default locales along with the provisioning resource groups.

Directory Abstraction Layer

Includes the following sections:

*

Entities: Including access properties, auxiliary classes, and LDAP classes.

*

Global lists: Including key and display label.

*

Queries: Including the query’s keys, parameters, and conditions.

*

Relationships: Including key, parent key, parent attribute, child key, and child attribute.

*

Configuration: Including default entity key, default locale, and container classes.

Provisioning Request Definitions
Includes:

+ A table containing the definition’s category, status, and e-mail notification.

Introduction to the User Application Design Tools
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+ An image of the workflow’s structure.

+ A section for each activity with a table that lists the data mappings for the activity or the
expression (if supported by the activity type).

+ A section for each form.

Provisioning Teams
Includes:

+ Display name

+ The team members

+ The request type and scope
+ The manager’s permissions

Role Catalog
Includes the following section:

+ Resources:
+ Roles: Including display name, description, role level, and categories.

+ Separation of Duties Constraints: Including display name, description, conflicting roles,
approval type, and approvers.

+ Role Configuration: Including role removal grace period, role level display names and
descriptions, approval types and approval definitions.
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Working with the Provisioning
View

This section provides details on using the Provisioning view. Topics include:

+ Section 2.1, “Setting Up a Provisioning Project,” on page 19

+ Section 2.2, “Accessing the Provisioning View,” on page 27

+ Section 2.3, “Setting Provisioning View Preferences,” on page 29

+ Section 2.4, “Importing Provisioning Objects,” on page 32

+ Section 2.5, “Exporting Provisioning Objects,” on page 33

+ Section 2.6, “Validating Provisioning Objects,” on page 33

+ Section 2.7, “Deploying Provisioning Objects,” on page 36

+ Section 2.8, “Comparing Provisioning Objects,” on page 38

+ Section 2.9, “Specifying Locales and Localization Resource Groups,” on page 39

+ Section 2.10, “Localizing Provisioning Objects,” on page 44
To perform many of the operations available from the Provisioning view (such as compare, import,
and deploy along with the wizards and editors), Designer must be able to establish a connection to
the Identity Vault. Designer generates error messages when it cannot connect to the Identity Vault
while performing these actions. To ensure that Designer is always able to connect to the Identity
Vault, you can choose to save the password when you configure the Identity Vault credentials for

your project. When you choose Save password, Designer saves the password to the local file system;
it is not secure.

2.1 Setting Up a Provisioning Project

The Provisioning view is only available for Designer projects that contain a User Application driver.
After you set up an Identity Manager project (see “Creating a Project” in the Designer for Identity
Manager 3.5: Administration Guide) and configure an Identity Vault and driver set for the project,
you add and configure a User Application driver.

To use Designer to configure the Roles tab of the User Application, you must additionally add a Role
Service driver to your project. See Section 2.1.2, “Adding a Role Service Driver,” on page 23 after
completing Creating a User Application Driver.

+ Section 2.1.1, “Creating a User Application Driver,” on page 19

+ Section 2.1.2, “Adding a Role Service Driver,” on page 23

+ Section 2.1.3, “Modifying the Role Service Driver Properties,” on page 26

*

Section 2.1.4, “About E-Mail Notification Templates,” on page 26

2.1.1 Creating a User Application Driver

1 Expand the project in Project view.

Working with the Provisioning View
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2 Double-click System Model.
3 Access the driver configuration page for a new driver by using one of these methods:
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+ Click Provisioning in the Palette, then drag a User Application icon onto the canvas.
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+ Click the driver set for your project and select Model > Driver > New.

|M|:u:IeI Window  Help

application *
Design Element L4
Domain Group L4
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Driver Set roo Copy k
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Library 4 Trace Sethings. ..
Palicy b Hamed Passwards, ..
Resource b Driver, Configuration, ..
Server b iMariager IGan. .

Engine Contrals...

[F__E Select Connected Applications

w

Designer displays the Driver Configuration Wizard.
Select one of these driver configurations.

Driver Configuration Description

User Application 3.0.1 Creates a Version 3.0.1 User Application driver.
User Application 3.5 Creates a Version 3.5 User Application driver.
User Application 3.5.1 Creates a Version 3.5.1 User Application driver.

User Application 3.6 Roles Based  Creates a Version 3.6 User Application driver (minimum
Provisioning Module needed to support roles)

User Application 3.6.1 Roles Based Creates a Version 3.6.1 User Application driver (minimum
Provisioning Module needed to support compliance)

This procedure describes how to configure all versions and indicates where fields are specific
to one version or another.

Designer launches the following:
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B Import Information Requested @

l"

““f’ The driver writer requested that the Following information be supplied in order to impart this driver File:

Information requested: * Required

Enter the driver name. Selecting an existing driver will overwrite the driver configuration. The driver name 'Userépplication’ was provided as a
default value by the configuration file.

Driver name: *

Crriver

Enter the distinguished name of the User Application Administrator. This is the user that will have rights to administer the User Application portal.
Use the eDirectory Format, i.e., admin.orgunit.novell, or browse to find the user. This is & required Field.

Authenkication 10: *

Enter the password of the User Application Administrator specified abowe,
Application Password &

Reenter the password:

Entet the User Application Context, This is the context portion of the URL For the User Application WaR file, The default is: IDM,
Application Contesxt:

oM
Enter the Host Mame or IP address of the application server where the User Application is running. For example, 'http:ffServerflame' or

‘https: {123,456, 75.99", This is a required field.
Hosk: *

Entet the Host port on the application server specified above, This is the port where the User Application is accessible e.q. 80, 8080, 8090,
Port:

Allow Owerride Initiator. Set ko Yes to allow the provisioning administrator to skart workflows in the name of the person For whom the
provisioning administrator is designated as proxy.

Allow Override Initiator:

Mo w

Reset ] I fext = l [ Finish ] [ Cancel

5 Fill in the fields as follows:
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Property What to Specify

Driver Name The name of an existing User Application driver
(the driver specified during the User Application
installation), or the name of a new User
Application driver.

Authentication ID The DN of the User Application Administrator.

Application password/Reenter password The password for the User Application
Administrator (above).

Application context The name of the User Application context, for
example, IDM.

Host The hostname or IP address of the application
server where the ldentity Manager User
Application is deployed. This information is used:

+ To trigger workflows on the application
server to connect to access workflows
(terminate, retract, and so on).

* To update cached data definitions.
Port The port for the Host (above).
Allow Override Initiator Applies to User Application Version 3.5 and later.

This property applies to workflows that are
started automatically. Workflows started
automatically are typically started under the
Admin identity. Selecting Yes for this property
allows those workflows to be started under
another user identity. For more information, see
the Identity Manager User Application:
Administration Guide.

6 Click Finish.

NOTE: When you create a User Application driver, e-mail templates for the User Application are
added to the Default Notification Collection. You must explicitly deploy them. They are not
deployed by default when you deploy the User Application driver.

2.1.2 Adding a Role Service Driver

1 Inthe same project where you created a User Application driver, click Provisioning in the
Palette, then drag a Role Service icon onto the canvas.
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2 Select one of the driver configurations, then click Run.

Driver Configuration Description

RoleService Creates a Version 3.6 Role Service driver.

RoleService_3 6 1 Creates a Version 3.6.1 Role Service driver (minimum needed to support
compliance)

Designer displays the Driver Configuration Wizard.
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® Import Information Requested
.\:."/ The driver writer requested that the following information be supplied in order to import this driver file:

Information requested: *Required

Enter the driver name, The driver name 'Role Service' was provided as a default value by the configuration file,
Driver name: *

| Role Service| |

The container root that will be serviced by the roles driver. Leave this blank if you want the roles driver to service the entire tree.
User-Group base container DN

' people.org |

The DM of the User Application Driver object that is hosting the role system.
User Application Driver DM *

: UserApplication.driverset.org |

The URL used to connect to the User Application in order to start Approval Workflows,
User Application URL =

, http://host:port/IDM |

The DM of the object used to authenticate to the User Application in order to start Approval Workflows.,
User Application Identity *

E user,department.org |

Password used to authenticate to the User Application in order to start Approval Workflows,
User Application Password *

Reenter the password:

[ Reset ] [ Mext = ] [ Einish ] [ Cancel
3 Fill in the fields as follows:
Field Description
Driver name The name of an existing Role Server driver (the

driver specified during the User Application
installation), or the name of a new Role Service
driver.

User-Group base Container DN (Version 3.6.1 only.) The driver acts only on
users, containers, and groups in this base
container. If there are group role assignments,
the roles driver only grants/revokes roles on
members within the domain of the container.

User Application Driver DN The DN of the User Application Administrator.

User Application URL The hostname or IP address of the application
server where the Identity Manager User
Application is deployed.

User Application Identity The name of the User Application context, for
example, IDMProv.

User Application password The password for the User Application
Administrator (above).

4 Click Next or Finish.
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2.1.3 Modifying the Role Service Driver Properties

After creating the Role Service driver, you can optionally modify some of the driver configuration
settings and modify the additional settings described in Table 2-1. To customize the additional
settings:

1 From the Outline view, select the Role Service driver, then right-click and select Properties.

2 Select Driver Configuration (in the left pane).

3 Open the Driver Parameters tab.

4 Navigate to the Driver Options tab. You can modify the driver’s properties that you specified
when you created the driver as well as the properties described in Table 2-1.

Table 2-1 Additional Settings for Customizing the Role Service Driver

Option Description
Number of days before processing removed The number of days the driver should wait before
request objects cleaning up request objects that have finished

processing. This value determines how long you
are able to track the status of requests that have
been fulfilled.

Frequency of reevaluation of dynamic and nested = The number of minutes the driver should wait

groups (in minutes) before reevaluating dynamic and nested groups.
This value determines the timeliness of updates to
dynamic and nested groups used by the User
Application. In addition, this value can have an
impact on performance. Therefore, before
specifying a value for this option, you need to weigh
the performance cost against the benefit of having
up-to-date information in the User Application.

Generate audit events Determines whether audit events are generated by
the driver.

2.1.4 About E-Mail Notification Templates

Identity Manager includes a standard set of e-mail notification templates (see “Working with E-Mail
Templates” in the User Application: Administration Guide). When you create a User Application
driver, any e-mail notification templates that are missing from the standard set are replaced.
However, existing e-mail notification templates, which might come from an earlier version of
Identity Manager, are not updated. To replace existing templates with new templates:

1 Expand the Outline view.
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2 In the Default Natification Collection, delete the e-mail notification templates that you want to

replace.

3 Right-click Default Notification Collection and select Update Templates.

You can also use this command at any time to update e-mail notification templates without

creating a new User Application driver.

4 To deploy the e-mail notification templates to the Identity Vault, right-click Default

Notification Collection and select Live > Deploy.

2.2 Accessing the Provisioning View

You can access the Provisioning view in the following ways:

*

*

*

Select Window > Show View > Provisioning.

In the Modeler window, right-click the User Application driver, then select Show View >

Provisioning View.

In the Outline view, right-click the User Application driver, then select Show Provisioning

View.

Select Provisioning from the FastView toolbar.

When it is open, the Provisioning view displays all of the provisioning projects located in the same
workspace. The contents of the view depend on what version of the User Application driver you
selected when you created the project.

Working with the Provisioning View
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Figure 2-1 Sample Provisioning View
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The Provisioning view displays icons to indicate the object’s status. The icons are described in Table
2-2.

Table 2-2 Provisioning View Status Icons

Icon Description

e Indicates that the local object has changed.

i Indicates that the local object contains a validation warning.

E:] Indicates that the local object contains a validation error.

The User Application driver icon includes a tooltip that provides the project's Identity Vault name,
the DriverSet, the driver name, and the version. Figure 2-2 shows an example of the tooltip for a
Version 3.5 User Application driver.

Figure 2-2 User Application Driver Tooltip

=B valocDriver 1026
[dentity
ault:: TestDrivers: :WalDocDriver 1026 W alDocDriver 1026
ersion = "IDM 3.5"

TIP: If you do not see the User Applications that you expect, it might be because the project is
corrupt. If your project is corrupt, you must re-create it.
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2.3 Setting Provisioning View Preferences

You can customize some Provisioning view behaviors by setting preferences. You access the
preferences page through Windows > Preferences > Novell > Provisioning. The preferences are
organized on the following tabs:

+ Section 2.3.1, “General Preferences,” on page 29

*

*

*

*

Section 2.3.2, “Import/Deploy Preferences,” on page 30
Section 2.3.3, “Migration Preferences,” on page 31
Section 2.3.4, “Validation Mask Preferences,” on page 31
Section 2.3.5, “Workflows Preferences,” on page 31

2.3.1 General Preferences

Table 2-3 General Preferences

Setting

Description

Prompt for deletion of
User Application
Configuration

Set delete from Identity
Vault as default for all
“Confirm Delete” dialogs

Show Provisioning View
when new User
Application is created or
imported

Show Tooltips in
Provisioning view

Show categories in
Provisioning View

Show all localized e-mail
templates

When selected and you delete a User Application from the Modeler,
Designer asks whether to delete the provisioning objects on disk as part of
the delete operation. By default, the provisioning objects are left on disk,
even if the User Application is deleted.

When you delete an object in the Provisioning view or the directory
abstraction layer editor, you are prompted to confirm the deletion. This
preference determines whether the check box labeled Delete object in
Identity Vault on deploy in the confirmation dialog box is selected by default.

Selecting this preference means the default is to delete the Identity Vault
object. The local object is always deleted.

Select this option if you want Designer to launch the Provisioning view when
you create a new or import an existing User Application driver.

Select this option to enable (the default) tooltips in the Provisioning view.

Select this option so Designer displays provisioning request definitions
organized by category. You specify the category in the Overview panel.
Categories are defined in the Provisioning Category list defined in the
directory abstraction layer.

Select this option so Designer displays all localized e-mail templates as
selectable options in the E-Mail notification tab. The Java language code is
appended to the name of the e-mail template. For example, cn=Provisioning
Notification Activity_es, cn=Default Notification Collection,cn=security
indicates this is the Spanish language version of this template.

When you select a localized template, that language is used regardless of
the user’s default language. When you select the default template (the
template without a locale code), the e-mail is in the user’s default language
(if the default is a supported language).

Working with the Provisioning View
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Setting Description

Validate display names for Select this option if Designer should validate display names. Itensure
supported locales uniqueness of the display name within a locale, and that a display name is
supplied (not blank) for each locale.

Applies to display names defined by using the directory abstraction layer
editor, provisioning request editor, or provisioning teams editor.

Prompt before performing When selected, and you click Run query in the Identity Vault, Designer

query on Role Entitlement informs you that the query can take a long time to execute. It prompts to run
the query or not. If this option is not selected, Designer runs the query and
does not prompt you.

Identity Vault Connection  The amount of time (in milliseconds) for Designer to connect to the Identity

Timeout (in milliseconds)  Vault. When set too low, you might encounter an error when settingTrustee
Rights on a provisioning request definition or when trying to access the
Identity Vault through the ECMA expression builder.

2.3.2 Import/Deploy Preferences

Table 2-4 Import/Deploy Preferences

Setting Description

Import Delete local object on import when object has been deleted in Identity Vault:
Select this option for Designer to delete local objects if the corresponding
Identity Vault objects were deleted. This ensures that the Identity Vault and local
files are in sync. Deselect this option if you want to leave the local files alone.

Import Prompt whether to overwrite runtime configuration on import from file: Select
this option if you are importing the driver from a test environment and want to
deploy to a production environment. The User Application driver runtime relies
on objects stored in the driver that you are not able to access in Designer. If you
deploy a driver that does not contain these objects, it does not work properly.
Deselect this option if you are importing the driver, modifying it, and deploying it
back to the same driver set because the driver already has the runtime
configuration objects.

Deploy Allow deployment of objects with validation errors: Select this option if you want
to deploy objects that fail validation checks. At deployment, Designer validates
the definitions being deployed following the validation rules outlined in
Section 2.6, “Validating Provisioning Objects,” on page 33. Deselect this option
to prevent deployment of definitions that fail validation.

WARNING: Deploying objects that fail validation can result in errors in the User
Application runtime.
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2.3.3 Migration Preferences

Table 2-5 Migration Preferences

Setting

Description

Show warning about
Identity Vault schema
changes

Always deploy (un-
deployed) User
Application Driver

Show warning that
editors will be closed

When you select Migrate, Designer displays a dialog box warning you that
schema changes (needed to support new features) must be made before you
can deploy the migrated driver. If the updates have not been made, cancel the
migration until they are complete. If you don't want to see this warning when you
select Migrate, deselect this option.

Applies to User Application drivers that have not been deployed to the Identity
Vault (for example, User Application drivers imported from a driver configuration
file). When you migrate an undeployed User Application driver, Designer
prompts you to deploy the driver. Select the Always deploy (un-deployed) User
Application driver option if you always want Designer to deploy the User
Application driver, and do not want the dialog box displayed.

When you select the Migrate command, Designer warns you that all editors will
be closed. Select this option if you don’t want this warning displayed each time
you choose the Migrate command.

2.3.4 Validation Mask Preferences

Table 2-6 Validation Mask Preferences

Setting

Description

Validation Mask Table

Use this to define the validation masks available to form controls. Validation
masks are regular expressions and must follow regular expression syntax.

Designer provides a default set of validation masks. If they do not display
validation masks in the form controls property sheets, enable them by clicking
Restore Defaults, then clicking Apply.

2.3.5 Workflows Preferences

Table 2-7 Workflow Preferences

Setting

Description

Form Templates

Diagram Preferences

Use this dialog box to remove or preview existing form templates.

Show Activity Id: Select this preference when you want the Workflow tab of the
provisioning request definition editor to display the Activity Ids for each activity
in the flow. Activity Ids are used by the ECMA expression builder and are written
to the User Application’s error logs.

Show Flow Path Types: Select this preference when you want the Workflow tab
of the provisioning request definition editor to display the Flow Path Types for
each activity in the flow. Flow Path Types are used by the ECMA expression
builder and are written to the User Application’s error logs.
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2.4 Importing Provisioning Objects

The Provisioning view’s import feature lets you import provisioning objects from:

+ A driver configuration file
+ An Identity Vault
This feature is useful when you begin a new project based on one or more definitions from an

existing project, or when you want to share definitions with other developers working on the same
project.

NOTE: When you change the Identity Vault or driver set’s deploy context, you must save the
project before performing an import. If you do not save the change, Designer continues to use the
old deploy context for import operations.

2.4.1 Importing from a Driver Configuration File

To import objects from a driver configuration file:

1 Open the Provisioning view.
2 Select the root node representing the type of object you want to import.

3 Right-click the container and select Import from File. Confirm the import operation (which
might overwrite existing definitions of the same name) by clicking OK.

4 Specify the name of the driver configuration file you want to import, then click OK.
Trustee information is stored in the driver configuration file. When you import a driver

configuration file using Designer, the trustee information is processed as expected. If you import the
driver configuration file using iManager, the trustee information is ignored.

2.4.2 Importing from an Identity Vault
1 Open the Provisioning view and select the container into which you want to import the
definitions.

To import a specific provisioning object, select that node in the Provisioning view. To import
all objects of a specific type, select the root node representing that type.

2 Right-click the container and select one of the following:
+ Live > Import to import the contents of the currently selected container.
+ Live > Import Object to browse the Identity Vault and select the object to import.

+ Live > Import From to browse the ldentity Vault and select a container whose contents
you want to import objects from.

If prompted, provide the Identity Vault credentials and click OK.

NOTE: For provisioning teams, Import Object imports only the team object. Import Team
Requests imports any associated team request objects.
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3 Navigate to the Identity Vault container or object that you want to import and click OK.

4 Review the Import Summary page to determine how you want to proceed. To complete the
import, click Import, or click Cancel. If you click Import, Designer performs the operation and
displays a summary of the completed operation.

2.5 Exporting Provisioning Objects

The Provisioning view’s export feature allows you to move project components from one project to
another without re-creating the contents. It also allows you to clone a project. You can use it to
export provisioning objects (and their children) to an XML-based driver configuration file. You use
the resulting file as the input to the Import from File feature, enabling you to easily share the
contents of your provisioning project with other developers.

To export to a driver configuration file:

1 Open the Provisioning view and select the object containing the definitions to export.

To export a specific provisioning object, select that node in the Provisioning view. To export all
of the objects of a specific type, select the root node representing that type.

2 Right-click the container or object and select Export to File.
3 Provide the name and location of the file to generate, then click OK.

The default name for the file reflects the contents of the file. For example, if you export lists,
the default name for the file is lists.xml. You can change the name as needed.

2.6 Validating Provisioning Objects

The Validation feature allows you to validate provisioning objects on the local file system before
you deploy. The validation runs Designer’s project checker and displays the results in the Project
Checker view.

You can validate provisioning objects individually, by node (such as the directory abstraction layer,
a provisioning team, or a separation of duty constraint), or at the User Application driver level. Each
node (individual, container-level, or driver-level) has a right-click menu item called Validate. In
addition, when you open an object in the editor, you can access the Validate option, for that item,
from Designer’s main menu and toolbar. For example, if you have a provisioning request definition
open in the editor, the main menu and toolbar provides a PRD > Validate menu option.

NOTE: Validation does not check the Identity Vault for the existence of any object.

Each object type has unique validation rules. They are described in each of the following sections:

+ Section 2.6.1, “Directory Abstraction Layer Objects,” on page 34
+ Section 2.6.2, “Provisioning Request Definitions,” on page 34

+ Section 2.6.3, “Provisioning Teams,” on page 34

+ Section 2.6.4, “Role Configuration Objects,” on page 34

+ Section 2.6.5, “Roles,” on page 35

+ Section 2.6.6, “Resources,” on page 35

+ Section 2.6.7, “User Application driver locales,” on page 36
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2.6.1 Directory Abstraction Layer Objects

Designer does the following:

*

Verifies that the XML is well-formed and complies with the schema that defines the elements
needed for entities, attributes, lists, relationships, and so on.

Checks every entity to ensure that references to other entities and global lists are valid.

For example, when validating an entity and its attributes, the validator checks that all
references to other entities via the Edit Entity, DNLookup, and Detail Entity references exist.

Ensures that every entity has at least one attribute defined.
Ensures that every local and global list contains at least one item.

2.6.2 Provisioning Request Definitions

Designer does the following:

*

Validates that every Provisioning Request Definition has at least one request form and one
approval form.

Ensures that the Condition Activity has both an outbound true flow path and an outbound false
flow path.

Ensures that the Entitlement Activity Data Item Mapping for DirXML-Entitlement-DN is
valid.

Ensures that the Final Timeout Action property (for User Activities) has a matching flow path
link leading from the activity. For example, if Final Timeout Action=denied, there must be a
denied link.

For Branch and Merge activities, ensures that a workflow has an equal number of Branch and
Merge activities. It also ensures that all paths descending from a Branch activity merge into one
Merge activity, that all merge activities have a branch activity, and that all Merge activities
have a branch-activity-id attribute.

Ensures that static list keys contain the correct data for the decimal data type.

2.6.3 Provisioning Teams

Designer does the following:

*

*

*

Validates that managers and members have been defined for the team.
Validates that team requests are specified for the team.

If the request scope is Categories, it validates that the team request actually references a
category.

2.6.4 Role Configuration Objects

Designer does the following:

*

*

Ensures that the Quorum value should be a number between 0 and 100. Validation rules take
into consideration that a percentage can be entered.

Ensures that the Removal Grace Period is a positive number.
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+ Ensures that Display Names and Descriptions use supported locales.

+ Ensures that the Provisioning Request Definitions defined for the Role Approval and SoD
Conflict Approvals are valid, are not templates, and whose process types match properly.

+ Separation of Duties (SoD) approvers must exist and be valid.

2.6.5 Roles

Before deployment, Designer validates that:

+ The category exists.

+ The description is provided for all supported languages.

+ The Quorum is a valid expression.

+ Approvers are present when the approval type is set to standard serial or parallel.

On deploy, Designer validates that the following objects exist in the Identity Vault:

+ The entitlement

+ The owner

¢ The Role Trustees

+ The lower-level roles

+ Groups

+ Containers

+ Approvers

+ Provisioning request definition

2.6.6 Resources

Before deployment, Designer validates that:

*

The category exists.

*

The description is provided for all supported languages.

*

The Quorum is a valid expression.
+ Approvers are present when the approval type is set to standard serial or parallel.

On deploy, Designer validates that the following objects exist in the Identity Vault:

*

The owner

*

The Resource Trustees
+ Approvers
+ Provisioning request definition
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2.6.7 User Application driver locales

For the User Application driver locales, Designer ensures that the locales contain descriptions and
display names. You can turn off the validation of display names for each locale by setting a
preference. For more information, see Section 2.3, “Setting Provisioning View Preferences,” on
page 29.

2.7 Deploying Provisioning Objects

The Provisioning view’s Deploy feature deploys your provisioning objects to the specified User
Application driver. You must deploy any changes you’ve made to the provisioning objects in the
design environment before you see them reflected in the Identity Manager User Application. The
Provisioning view allows you to deploy a container and all its children (for example, all entities or
all lists), or to deploy just a single provisioning object (such as a single list element). When you
select an item to deploy, Designer compares it to the same item in the Identity Vault. If the items are
equal, Designer prevents you from deploying. When there are differences, Designer displays them
and allows you to proceed or to cancel the deployment.

NOTE: When you change the Identity Vault or driver set’s deploy context, you must save the
project before performing a deploy. If you do not save the change, Designer continues to use the old
deploy context for deploy operations.

Deployment and Versions

If you deploy a Version 3.5 User Application driver and the Identity Vault does not contain the
necessary 3.5 schema changes, the provisioning objects are not deployed and Designer displays an
error message in the Deploy Results dialog box. This is to prevent you from deploying a 3.5 driver
to a 3.0.1 Identity Vault.

2.7.1 Deploying Provisioning Objects

1 Save any changes.

If the objects contain unsaved changes, Designer displays the unsaved definitions and prompts
you to save them. If you do not, Designer still deploys the objects but does not deploy the
unsaved changes. Choosing not to save the changes does not cancel the deployment.

2 Open the Provisioning view, right-click the object to deploy, then select Live > Deploy or Live
> Deploy All.

To deploy a specific provisioning object, select that node in the Provisioning view. To deploy
all of the objects of a specific type, select the root node representing that type.

Designer prompts you for Identity Vault credentials (if necessary), validates the objects, and
writes any messages to the project checker view.

When you deploy a driver that contains provisioning objects that fail validation, Designer
deploys the driver but not the invalid objects (regardless of the deployment preferences).
Designer displays the errors in the deployment result dialog box.

When you deploy a provisioning object that contains validation errors, Designer performs the
deployment based on the defined preferences and writes the errors to the Project Checker view.
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Tips for Deploying Provisioning Request Definitions

+ If errors associated with activities are detected during deployment of a provisioning request
definition, Designer identifies the activity in which the error occurred by activity Id. However,
in the user interface, Designer by default displays activities by activity name. To make it easier
to identify the activity in an error message, turn on the display of activity Ids before you deploy
the provisioning request definition. To turn on the display of activity Ids, right-click the
Workflow canvas and select Show Activity Ids.

+ A common error occurs when you fail to replace a placeholder expression in an entitlement
provisioning activity. If this is the case, correct the error, then deploy the provisioning request
definition again.

+ Designer cannot evaluate expressions at design time, so it might display a warning when you

use an expression for an entitlement that must be resolved at runtime. This is not a fatal error
and the deployment will succeed.

+ Make sure that the Status is Active (in the Overview tab).

+ If a provisioning request definition with the same CN already exists in the Identity Vault, the
Deployment Summary displays the differences. You can review the differences before you
decide to proceed.

Deploying Roles

Because roles can be related through a role hierarchy, Designer notifies you, on deploy, if the role
you are deploying contains any dependent roles. To ensure that roles in the Identity Vault are in a
valid state, Designer requires that you deploy the role and any dependent roles at the same time by
displaying them in the dialog box shown in Figure 2-3 on page 37.

Figure 2-3 Deploying Dependent Roles

Deployment Dependencies

To deploy the selected objects, you have to deploy the Following dependent objects as well,

I2) [ Ok, ] [ Cancel

2.7.2 Testing the Deployed Changes

You can access the User Application from within Designer to view or test what you deploy:

1 Select Tools > Access User Application.
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2 Choose the project and User Application driver container associated with the User Application
you want to view, then click OK.

Designer uses the driver configuration information that you defined for the project to make the
connection. Designer uses the browser settings specified in Windows > Preferences > General
> \Web Browser

2.8 Comparing Provisioning Objects

The Provisioning view’s Compare feature allows you to see the differences between the
provisioning objects in the local file system and those that are running in the deployed User
Application driver. When Designer encounters a difference, it allows you to specify what action you
want to take on that difference. You can ignore or reconcile it.

NOTE: When you change the Identity Vault or driver set’s deploy context, you must save the
project before performing a compare. If you do not save the change, Designer continues to use the
old deploy context for compare operations.

To compare provisioning objects:

1 Right-click a container or object in the Provisioning view, then select Live > Compare.
2 If prompted, provide Identity Vault credentials, then click OK.

Designer displays the results of the comparison. By default, only the differences are displayed,
but you can show the full comparison by deselecting Only show differences.

NOTE: For provisioning teams, you must select the container to compare the provisioning
request and provisioning team objects. If you select an individual team, it compares only the
provisioning team objects.

3 If there are differences, select one of the following actions:

Reconcile Status Description

Do not reconcile Do not change any definitions.

Update Designer Import the definitions from the Identity Vault.

Update eDirectory Deploy the definition from Designer to the Identity Vault.

Reconciled by parent For informational purposes. Specifies whether one of the parent objects is
already being reconciled. It is always disabled and is only set if the parent
object is already being reconciled to Designer or the Identity Vault.

If a provisioning request definition or role object contains trustees, the trustees for the local object
are compared with the trustees defined for the object in the Identity Vault. Trustees are not compared
for directory abstraction layer objects.
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2.9 Specifying Locales and Localization
Resource Groups

You can use Designer to define:
+ The User Application driver’s default locale. It is the locale used to display content when a
match for the user’s locale cannot be found.
+ The locales supported by the User Application driver. You can add new locales as needed.
+ Custom localization resource groups for specialized field localization.

NOTE: The ability to specify locales and localization resource groups is only available for User
Application drivers for Version 3.5.1 (and later).

2.9.1 Specifying the Default Locale

To specify the User Application driver’s default locale:

1 Right-click the User Application driver in the Provisioning view, then select Configure >
Default Locale.

2 Select the locale from the drop-down list box, then click OK. If you do not see the locale in the

list, you must add it through the Locales dialog box.

2.9.2 Defining the User Application’s Supported Locales

1 Right-click the User Application driver in the Provisioning view, then select Configure >
Locales. Designer displays the Supported Locales dialog box.

® EEX

Locales and Localization Resource Groups

() Specify the locales and resaurce groups that should be used for Roles_Userépplication,

Locales . Localization Resource Groups

+ &
Locale Display Marne
de German

English

Spanish

0% 0% X % MK OK MK KN
FHETRANRRBATER

H
=
i
b
5

Working with the Provisioning View

39



Button Description

4}_' Lets you add a new locale to the list of locales supported by the User

L Application driver. When you click the Add button, Designer prompts you for
the Language and Country. You can either select them or type a value. The
Language is required and displays as the locale. The country is not required.

4 Deletes the selected Locale from the supported list. Any files for the selected
locale are not deleted.

Lets you localize all supported locales in one dialog box. When you click the
button, it launches this dialog box:
@ Localize Q@E
Select the target language and fillin the values
Source language: | German | Target lanquage: ¥

Origin  Source Target

de Deutsch German

en Englisch English

es Sparisch Spanish

fr Franzdsisch French

it Italienisch Italian

ia Japanisch Japanese

nl Miederlandisch Dutch

Pt Portugiesisch Portuguese

You can select the source language from which you want to translate the
names of the supported locales. Select the target language into which you
want to translate the names of the supported locales. Type the translation in
the Target field.

B Lets you localize the display labels for the selected locale. This is the same
procedure described in Section 2.10, “Localizing Provisioning Objects,” on
page 44.

type the value. The language is required, but the country is not. The language is displayed as
the Locale in the Supported Locales dialog box.

3 Click OK.

4 Click Resource groups, then click the localization resource group that you want to support the
new locale.
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Locales and Resource Groups

@ Specify the locales and resource groups that should be used For WalDocDriver07 1707,

Locales | Resource Groups
+
+ Default Locales
b Accessory Portlets
» Base
» Administrative
b Requests and Approvals
» Identity

b Password Managment

(2 Ok ] [ Cancel ]
5 Click i 9 in the Locales area, then select the locale from the Available Locales list and move it
to the Selected Locales list, then click OK.
2 3
Add Locales

Add one or more locales to the Identity resource group

Available Locales: Selected Locales:

Albanian {Albania)
Armenian {Armenia) .
v B

&

@ Ok ] [ Cancel

2.9.3 Creating a Custom Localization Resource Group

1 Right-click the User Application driver in the Provisioning view, then select Configure >
Locales. Go to the Localization Resource Groups tab.
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® CBX

Locales and Localization Resource Groups

(Z) Specify the locales and resource groups that should be used For Roles_UserApplication,

Lacales |Localization Resource Groups
+
+ Default Locales

} Common

-

Accessory Portlets

-

Base

-

Administrative

-

Requests and Approvals

-

Identity

-

Password Management

-

Roles

5

New Localization Resource Group

Create new resource group by specifying identifier and display name

Identifier: | |

Display Mame: | |

@ Cancel

3 Complete the fields as follows:

Field Description
Identifier A unique name used to identify the localization resource group.
Display Name The name displayed in Designer to correspond with this group.

4 Click OK. The Localization Resource Groups property dialog box displays:
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Locales and Localization Resource Groups

(Z) Specify the locales and resource groups that should be used For Roles_UserApplication,

Lacales |Localization Resource Groups

+ &

+ Default Locales

-

Common

-

Accessory Portlets

-

Base

-

Administrative

-

Requests and Approvals

-

Identity

-

Password Management

-

Roles

~ Test b4
Identifier: Test_Resource_Graup

Display Marne: Test =

Descripkion: | &
Required Group: w
Locales:
4
#
®

5 Complete the fields as follows:

Button Description
4}_' Lets you add a new localization resource group.
4 Deletes the current localization resource group.
Lets you localize the localization resource groups in one dialog box.
Description Lets you add descriptive text for this entry.

Required Group

Lets you specify dependencies on other localization resource groups.

Localization resource groups are used for creating resource bundles for non-
standard language. The required groups are defined in the User Application:
Localization Toolkit Guide. Contact your Novell Sales Representative for more
information about the toolkit.
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Button Description

Locales Lets you add or remove the locales into which this localization resource group
must be localized. If the locale is not on the list, see “To specify the User
Application driver’s default locale:” on page 39.

2.10 Localizing Provisioning Objects

Designer allows you to translate the names and descriptions of provisioning objects into multiple
languages. Table 2-8 describes the types of provisioning objects that you can translate.

Table 2-8 Localizable Objects

Designer Tool Description

Directory Abstraction Layer Editor + Entity and attribute display labels
+ Relationship names
¢ Global and local list items

¢ Query display labels and parameter display labels

Provisioning Request Definition Editor * Activity properties that are displayed to the user

+ Form properties that are displayed to the user
Provisioning Team Editor ¢ Provisioning team display name and descriptions

Roles Catalog + Resource display label and description
+ Role display label and description
+ Separation of Duties display label and description

+ Role level display label and description

To localize the provisioning objects listed in Table 2-8:

1 Verify that the locale (or language) is supported by the User Application driver. See
Section 2.10.2, “Supported Languages,” on page 46 for the list of languages supported by
default.

2 If necessary, add the new locale (or language) to the User Application driver and to the resource
groups. For more information, see Section 2.9.2, “Defining the User Application’s Supported
Locales,” on page 39.

3 Translate the names and descriptions in one of the following ways:
3a Directly within Designer.

NOTE: You cannot edit the provisioning request definitions in the Attestation category.
For this reason, you cannot use this method for localizing them. You must use the method
described in Step 3b.

For more information, see Section 2.10.1, “Using Designer to Localize,” on page 45.
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3b By exporting the set of localizable objects into an external properties or XML file,
translating the contents of the file, then importing the data back into the project.

For more information, see Section 2.10.3, “Exporting and Importing Data to Localize,”
on page 46).

2.10.1 Using Designer to Localize
1 Click the localize button.

&=l

When you click this button, Designer displays a dialog box that lets you add the localized text.
This is an example of the Localization dialog box.

® Localization E]

Localization

@ Specify the localized string values for "Group”,
Chinese {China): | 2 !
Chinese {Taivwan): | e |
Dakch: | Grogp |
English: | Group |
French: | GroUpeE |
(EErTNar: | Gruppe |
Italian: | Gruppo |
Japanese: | HL—7 |
Paortuguese: | Grupo !
Russian: [Fp';-'nna i
Spanish;: | Grupo |
Siwedish: | Grupp |

@ [ oK ] [ Cancel ]

The languages displayed in this dialog box are the languages currently supported by the User
Application driver. If your language is not shown in this dialog, you must add it. For more
information, see Section 2.9.2, “Defining the User Application’s Supported Locales,” on page 39.

The directory abstraction layer editor provides multiple ways to localize data. You can access the
localization dialog boxes in these ways:
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Table 2-9 Accessing the Localization Dialog Boxes

To define the localization text for... Perform this action...

Every localizable item in the directory Select DAL > Set Global Localization.

abstraction layer
or

Click Set Global Localization (from the editor’s toolbar), then
select the Target Language before entering the localized
text in the Target field.

A specific entity, relationship, or list From the tree view, right-click the object to localize, select
Localize, then select the Target Language before entering
the localized text in the Target field.

A single display label Select a specific entity or attribute, then click Localize
Display Label (beside the Display Label field in the Property
pane).

2.10.2 Supported Languages

You can localize the display labels, display names, and descriptions into the languages listed in the
localization dialog box. This list represents the languages (locales) supported by the User
Application driver. For information about adding new languages to this list, see Section 2.9,
“Specifying Locales and Localization Resource Groups,” on page 39.

The locale configuration is stored in the driver’s <default-locale> element in the
AppConfig.AppDefs.locale-configuration XMLData attribute.

You must provide a display label for the User Application driver’s default language, or the User
Application generates the following runtime error: The resource resolver
com.novell_soa.common.i18n.LocalizedMapResolver did not return a resource for
the default locale of <locale>. It is required that a resource exist for the
default local.

2.10.3 Exporting and Importing Data to Localize

You can export the localizable data (such as display names and descriptions) in your project to an
XML or properties file. After the data in that file is translated, you can import it back to the Designer
project. You can export an entire driver, one object, or a subset of objects.

+ “Exporting Data to Localize” on page 46
+ “Importing Localized Files” on page 48
Exporting Data to Localize

1 Right-click a container node or an object in the Provisioning view.
2 Select Localize > Export Localization Data.
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Export Localization Data

Select the Folder to store the exported localization data.

File Locations

Store in Folder: | Ci\Documents and Settings'testpworkspacelwalDocDriver 1026 \ProvisioningappConfig|Request Defs | [Browse... ]

Prefix For generated Files: | WalDocDriver 1026_Provisioning Request Definitions

File bype: [@F: ¢ (%) Properties

Languages

Select the languages to expork:

Locale Language
O nl Dutch
O &n English
O fr French
O de GErmEn
O it Italian
O ja Japanese
O uls Portuguese
O zh-CN Simplified Chinese
| a5 Spanish
O zh-Tw Traditional Chinese

[JPrompt before overwriting existing files

3 Fill in the fields as follows:
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Field

Description

Store in folder

Prefix for generated files

File Type

Select the languages to export

Prompt before overwriting existing files

Specify the name of a local folder where the
exported files should be written.

Specify a prefix for the generated files.
Determine a naming strategy so you are able to
identity the files for projects.

Select XML or Properties depending on the
encoding or format you prefer. XML files are
UTF-8 encoded. Properties use Unicode*.

Select the languages you want localizations for.
A file containing the display label key is
generated for that language. The localizations
need to be added to this file in the proper format
S0 you can import them to the proper User
Application driver objects.

If this option is selected, Designer prompts you
before it overwrites any existing files of the same
name in the target directory.

4 Click Finish. Designer displays a message describing the result of the export operation and the

location of the exported data.

Importing Localized Files

1 Right-click a container node or an object in the Provisioning view, then select Localize >

Import Localization Data.
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Import Localization Data

Select the Folder containing the localization Files to import,

Search in Folder: | C:\Documents and SettingsitestiworkspacelwalDocDriver 1 026\ ProvisioningbAppConfigiRequestDefs | [Browse... ]

File bvpe Preferences

@ wML I:‘ Suppress warnings about unused strings

() Properties [] Create backup of existing display label strings
Files

Select the files bo import:

File: Language

@

2 Fill in the fields as follows:
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Field

Description

Search in folder

File Type

Preferences

Files

Specify the folder location where the files to
import are located.

Select XML if the file you want to import is in
XML format.

Select Properties if the file you want to import is
in the properties format.

Select Suppress warnings about unused strings
if you want the wizard to suppress warning
messages.

Select Create backup of existing display label
strings if you want the wizard to create a backup
of the existing strings before the import. Useful in
case you need to revert.

Select the files to import. This table is populated
with the files from the folder location and file type
specified above. If it is blank, no files of the
specified type are located in the target folder.
The wizard attempts to determine the language
by looking at the filename. If the name cannot be
determined, it defaults to English.

You can change the Language column if the
wizard assumes the wrong language. The wizard
changes the filename to reflect the language you
specify and import the display labels to the
corresponding language.

3 Click Finish to complete the import. Designer displays a status dialog box that describes the
results including any errors reading the files and any warnings about display label keys that are

unused.
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Configuring the Directory
Abstraction Layer

This section provides details on configuring the directory abstraction layer. Topics include:

+ Section 3.1, “About the Directory Abstraction Layer,” on page 51
+ Section 3.2, “Working with Entities and Attributes,” on page 55

*

Section 3.3, “Working with Lists,” on page 63

*

Section 3.4, “Working with Queries,” on page 67

*

Section 3.5, “Working with Relationships,” on page 70

*

Section 3.6, “Working with Configuration Settings,” on page 73

*

Section 3.7, “Directory Abstraction Layer Property Reference,” on page 74

3.1 About the Directory Abstraction Layer

The directory abstraction layer is a set of XML-based files that define a logical view of an Identity
Vault for the User Application. The User Application uses the directory abstraction layer definitions
to determine:

+ The Identity Vault objects and attributes that the User Application can display or modify.

+ How the User Application displays Identity Vault data.

+ The relationships the User Application can display.

+ The provisioning request categories, e-mail notification types, and delegate relationships the

User Application can display.

The User Application ships with a default set of entities, relationships, and lists that it needs to
function, but you can add new or modify existing directory abstraction layer objects to customize
the User Application for your own business needs. You use the directory abstraction layer editor
(described in Section 3.1.2, “About the Directory Abstraction Layer Editor,” on page 52) to define
the contents of the directory abstraction layer.

3.1.1 Analyzing the User Application’s Data Needs

Before you make changes to the directory abstraction layer objects, analyze how you want to display
your Identity Vault data in the User Application. Consider:

+ What parts of the Identity Vault you want to make available to the User Application.

For example, what objects do you want your users to be allowed to search and display? Check
this list against the base set of abstraction layer definitions to determine if you need to add any
new objects.

+ What is the structure of your Identity Vault schema? Have you added custom extensions and
auxiliary classes?
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+ What is the structure of your data?
+ What is required and what is optional?
+ What validation rules are in place?
+ What are the relationships between objects (DN references)?

+ How are the attributes defined? (For example, an attribute that represents a phone number
might be multi-valued for home, office, and cell phone numbers)

+ Who sees the data? Is the User Application available as a public or private site?

Use the information about your data needs to map your Identity Vault objects to abstraction layer
entities.

3.1.2 About the Directory Abstraction Layer Editor

The directory abstraction layer editor is a graphical tool for defining the directory abstraction layer
files. When you add a User Application driver to an Identity Manager project and run the
configuration wizard, Designer creates an initial set of directory abstraction layer files. If you do not
run the configuration wizard, the initial files are not created. These base files are displayed when
you start the directory abstraction layer editor.

To start the directory abstraction layer editor:

1 Open the Provisioning view and double-click the Directory Abstraction Layer node.

Designer displays the directory abstraction layer tree containing nodes for Entities, Lists,
Queries, Relationships, and Configuration.

074 Entities

[ Lists
@ Queries

@ Relationships
L4 Configuration
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Node Description

Entities Entities represent the Identity Vault objects
available to the User Application. There are two
types of entities:

¢ Entities mapped from the schema: Entities
that represent Identity Vault objects directly
exposed to users via the User Application.
Users can typically create, search, and
modify the attributes of these entities.

¢ Entities representing LDAP relationships:
Called DN lookups, these entities represent
indexed searches and are used to support
particular types of attributes in the User
Application. DN lookup entities provide
information about relationships between
LDAP objects. DN lookup entities are:

¢ Used by the Org Chart portlet to
determine relationships.

+ Used in the Search List, Create, and
Detail portlets to provide selection lists
and DN contexts.

¢ Available to the workflow request and
approval flow forms you define using
the provisioning request definition
editor.

Lists Defines the contents of global lists. Global lists
are:

+ Associated with an attribute. The User
Application displays the attribute values as
a drop-down list in the User Application.

+ Used to display Resource Request
categories.

Queries Lets you define LDAP search criteria that can be
run from a workflow form.

Relationships Lets you map hierarchical relationships among
schema-based entities. Used by the
Organization Chart action of the Identity Self-
Service tab of the User Application and in
iManager when defining provisioning s.

Configuration General configuration parameters.

2 Use the left pane to navigate the directory abstraction layer nodes. When you select an item in
the left pane, the right pane displays the properties for the selection.

3 Use the right pane to define the properties for the selection. For more information about the
properties, see Section 3.7, “Directory Abstraction Layer Property Reference,” on page 74.

The following table describes the directory abstraction layer toolbar:

Configuring the Directory Abstraction Layer

53



Table 3-1 Directory Abstraction Layer Toolbar

Toolbar Button Description
J‘]F Launches the Add Entity Wizard.
@ Launches the Add Attribute Wizard.
& Launches the New List Wizard.
Q Launches the New Query Wizard
Launches the New Relationship Wizard.
-
_.l

& Launches the Set Global Access Modifiers dialog box.
O Launches the Set Global Localization dialog box.

Expands and collapses the directory abstraction layer tree.

3.1.3 About Directory Abstraction Layer Editor Files
The directory abstraction layer files you work with are stored in the Designer project’s

Provisioning\AppConfig\DirectoryModel directory. The filenames are derived from the object
key.

Table 3-2 Local Directory Abstraction Layer Directories

Directory name Description

ChoiceDefs Contains the files that define global lists. Files have the choice extension.

EntityDefs Contains the files that define the entities and attributes. Files have the entity
extension.

QueryDefs Contains the files that define queries. Files have the query extension.

RelationshipDefs  Contains the files that define the relationships available to the Org Chart portlet
and iManager provisioning configuration. These files have the relation
extension.

Designer creates the base set of directory abstraction layer files for each provisioning project. An
identical set is added to the User Application driver when the User Application is installed.
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To customize the Identity Manager User Application, you change the directory abstraction layer
objects and the changes to the User Application driver. Some entities, attributes, lists, and
relationships are required for the User Application to function properly. The editor displays a lock
next to the definitions that you should not delete. From the list below, you can see that you should
not delete the Group, User or User Lookup entities.

Figure 3-1 DAL User Application Default Entities, Lists, and Relationships

Al | S mE

-4l Group

[ User

+ Jj User Lookup

=[] Lists

|—,_‘, Delegate Relationship
|—,_‘, Email natification bypes
|—,_', Provisioning Category
|—,_‘, Roles Category

@ Queries
= @ Relationships
#1 Group's membership
#4 Manager-Emploves
#9 User groups
4 Corfiguration

If you define multiple User Application drivers in a single project, Designer creates multiple
AppConfig folders and names them AppConfig, AppConfigl, AppConfig2, and so on.

3.2 Working with Entities and Attributes

You can customize your User Application by adding objects and their attributes based on the content
of your own Identity Vault. You do this by adding new entities and attributes to the directory
abstraction layer and deploying them to the User Application driver.

To modify the entity files installed by default, see Section 3.2.2, “Adding Entities,” on page 56 and
Section 3.2.3, “Adding Attributes,” on page 61. To modify the entity files of an already ed project or
a set of files defined by another developer, you must first import the files to your design
environment. For information on importing files, see Section 2.4, “Importing Provisioning Objects,”
on page 32.

3.2.1 About Entities and Attributes

Any Identity Vault object that you want users to search, display, or edit in the Identity Manager User
Application must be defined as an entity in the directory abstraction layer. For example, to use the
inetOrgPerson Identity Vault object in the User Application, you must create an entity definition for
it. There are two logical kinds of entities (but you create them the same way):

+ Entities that are mapped from schema: These entities represent objects that exist in the
Identity Vault that are directly exposed to users in the User Application. When defining this
type of entity, expose all of the attributes that you want your users to work with. Examples of
this entity type include User and Group. You can create more than one entity definition for the
same object to expose different sets of attributes to different kinds of users. For more
information, see “Creating Multiple Entity Definitions for a Single Object” on page 56.
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+ Entities that represent LDAP relationships: This type of entity is known as a DNLookup and
it is used by the User Application to:

+ Populate a list with the results of a DN search among related entities
+ Maintain referential integrity across DN referenced attributes during updates and deletes

Entities that support DNLookups are used by the Org Chart portlet to determine relationships
and are also used by the Search, Create, and Detail portlets to provide pop-up selection lists and
DN contexts. The User Lookup entity is an example of this type of entity. For more
information, see “Attributes and DNLookup Properties” on page 83.

Creating Multiple Entity Definitions for a Single Object

You can create more than one entity definition that represents the same Identity Vault object but
provides a different view of the data. Within the entity definitions, you can define different attributes
for each entity definition, or you can define the same attributes but specify different access
properties that control how the attributes are searched, viewed, edited, or hidden.

NOTE: You can optionally define a filter to hide certain entities from the result set.

You can then use these different entity definitions in different parts of the user interface. For
example, suppose that you want to create a directory of employees; one for a public site and one for
an internal site. On the public site you want to supply first and last names and a phone number, but
on the internal site, you want to list additional information like title, managers, and so on. Here’s
how you can accomplish this:

1 Create two entity definitions (with different keys).

Both entity definitions expose the same Identity Vault object, but one entity definition key is
public-staff-information, and the other is internal-staff-information.

2 Within each entity definition, define a different set of attributes: one for public-staff-
information, the other for internal-staff-information.

3 Use the Portal Administration tab of the Identity Manager User Application to create a portlet
instance for the public page, and another one for the internal page.

For more information about creating portlet instances, see the Portlet Reference section in the
Identity Manager 3.5 User Application: Administration Guide.

3.2.2 Adding Entities

You add entities through the Add Entity Wizard (described in the next procedure) or by clicking Add
Entity (from the toolbar).

NOTE: When using the Add Entity button, you are prompted to select the object class of the entity
to create, and the editor automatically adds the required attributes to the entity. Use the Add
Attribute dialog box to complete the entity definition.

To add an entity using the Add Entity Wizard:

1 Launch the Add Entity Wizard in one of these ways:
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From Designer’s menus:

+ Select File > New > Provisioning. Choose Directory Abstraction Layer Entity, then click

Next.
From the Provisioning view:
+ Right-click the Entities node, then choose New.
From the directory abstraction layer editor:
+ Select DAL > New > Entity
or

+ Right-click the Entities node, then choose New Entity-Attributes Wizard.

The New Entity dialog box displays.

NOTE: If launched from the File menu, the dialog box contains the additional fields shown

below.

Mew Entity

Specify project and application For the new entity as well as the display name and
kery For the new entity,

Identity Manager Project: |Pr0ject0ne

Provisioning Application: |User Application

Enkity Key: |

Display Label; |

Cancel

2 Fill in the fields as follows:
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Field

Description

Identity Manager Project and
Provisioning Application

Entity Key

Display Label

The Identity Manager project and the provisioning
application where you want to add the entity and
attributes.

NOTE: These fields display when you launch the wizard
from the File menu.

A unique identifier for the entity.

The string displayed when the entity is displayed by the
User Application. You can localize this label. For more
information, see Section 2.10, “Localizing Provisioning
Objects,” on page 44.

3 Click Next. The New Entity dialog box displays:
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MNew Entity

Select the Object Class that will define your new Entity,
Then select and add any Attribubes you want created in the Entity.

Select Object Class:

E:i:;‘sSer\-'er w == Configure Filker. ..
applicationEntity

applicationProcess

audit:File Object

Bindery Object

Bindery Queue

CommExec

Campukter

Counkry

cRLDiskributionPoink

Device

Directory Map

Diir=ML-Drrivver

Dir£ML-Driver et e

By ailable Attributes For Enkity: Selected Attributes in Entity:

4 Choose the entity’s object class and add the attributes you want by double-clicking them in the
Available Attributes for Entity list. Mandatory attributes are added when you select an Object
Class, and you cannot remove them from the Selected Attributes in Entity list.

TIP: If the entity’s object class is not shown in the Select Object Class list, you should update

Designer’s local schema file by following the steps described in “Updating the Schema
Elements List” on page 63.

5 Click Finish.

The property page displays for editing. For more information, see “Entity Properties” on
page 74. You must deploy the entity before it is available to the User Application.
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Filter the Object Class List

You can limit the object classes shown in the New Entity dialog box by adding a filter. To add a

filter:

1 Click Configure Filter to launch the Class List Filters dialog box.

E“-:,]. Class Filters

Manage the filkers applied ko the Class list,

conkains w

starts-with 'DirsML’
starts-with ‘spvpry’

[SE|E.'I:|Z all ] ’Deselect all ]

Ik, ] ’ Cancel

By default, Designer does not apply any class filters. The Class Filter dialog box contains two
predefined filters (starts-with "DirXML" and starts-with "srvprv"). To activate them, click

Select All, then click OK. The filters are immediately applied to the object class list. Filters are
applied until you deselect them.

2 Use the buttons as follows:

Button

Description

conkains w | |

Choose one of the string comparison operators, such
as contains, starts-with, ends-with, then type the
string to compare against.
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Button Description

Adds a filter. Enabled when you define the filter
r comparison value.

Removes the selected filter.

Click this option when you want to use all of the

filters. It selects all of the defined filters.

Click this option when you want to deselect all of the
ki defined filters. If you apply this change, no filters are

used.

Adding Entity Filters

You define an entity filter to limit the entries returned for the specified entity. You define the filter
based on attributes and their comparison to another value that you specify. For example, you can
create a filter so that the User entity includes only those entries whose Region attribute contains
Northeast.

1 Click Add Condition Grouping.

- Filter
Specify attribute filter conditions Far the entity:

(%P Add Condition Grouping

(% Remaove Condition Grouping b

Region “ | | contains w b4

Use the drop-down list on the left to select an attribute.
Use the drop-down list in the middle to select a comparison operation.
Use the entry on the right to specify a value for comparison.

ga b~ 0N

To specify multiple condition groupings, repeat this procedure. Within a condition grouping,
you specify each criterion that you want and connect them by using the logical operations: and,
or.

The conditions are evaluated in the order in which you define them.

3.2.3 Adding Attributes

1 Select an entity.
2 Do any of the following to add an attribute:
+ Right-click an entity, then select Add Attribute.
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or

+ Click the Add Attribute button.
or

+ Click DAL > New > Attribute.

You are prompted to choose the entity class that contains the attributes that you want to add to
the entity. You can also add (and remove) auxiliary classes if you need to add a class that
contains the attribute you are looking for.

Add Attribute

@ Select an Entity to display its list of available directory attributes,
Then select and add any attribubes vou want created in wour Entity,

Selected Entity:

N |

Entity Classes:

’Addp’Remnve aux classes, .,

Available Attributes For Entity Class: Entity Attributes:

DAL Calculated Attribute S = (4 Group
ACL . -~
fudit:Fils Link L’;—!‘ Description
Authority Revocation @ Members
auxClassCompatibilicy
Back Link,

Bindery Property
businessiCateqary

CA Private Key

A Public Key

Certificabe Revocation
Certificate Yalidity Interval
M

creatorshame

Cross Certificate Pair
Description

Dir 2ML-Associakions

EMail Address

Equivalent To Me

Full Mame

[11n]

GUID

L
Lask Referenced Time L

)] [ oK H Carcel l

3 Add attributes by double-clicking them in the Available Attributes for Entity Class list.

LDAP operational attributes are supported by the directory abstraction layer editor and User
Application; however, when you add an operational attribute, the Edit, Required, and Hidden
properties are set to false and are disabled so you cannot change these property values.

TIP: If the attribute you want to add is not displayed in the Available Attributes from Entity
Class list, you should update Designer’s local schema file by following the procedure in
“Updating the Schema Elements List” on page 63.
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4 Click OK. The property page displays for editing.

For more information, see “Attribute Properties” on page 78. To make an attribute available to
the User Application, you must deploy it.

Adding DAL Calculated Attributes

You can create an attribute that is derived from an expression. For example, you can concatenate two
or more attributes to produce a single calculated value. The expressions are ECMAScript compatible
and conform to the ECMA 262 Language specification.

Restrictions: Because this attribute type does not map to a specific attribute in the Identity Vault,
these attributes cannot be updated, removed, multivalued, required, or searched.

To create a calculated attribute:

1 Add an attribute as instructed in Section 3.2.3, “Adding Attributes,” on page 61 and make sure
to select DAL Calculated Attribute from the Available Attributes for Entity Class list.

Designer adds the Attribute with the following restrictions:

Table 3-3 Calculated Attribute Properties

Property Name Description

Expression Click Build ECMAScript Expression to launch the
ECMA Expression Builder. To learn more about
how to use the ECMA Expression Builder, see
Chapter 9, “Working with ECMA Expressions,” on
page 321.

3.2.4 Updating the Schema Elements List
1 With the Identity Manager project open, right-click your Identity Vault, then select Live >
Import Schema.
2 Choose Import from eDirectory and provide the specifications for the eDirectory host.
3 Click Next.
4 Select the classes and attributes to import, then click Finish.

3.3 Working with Lists

The lists node lets you define the contents of global lists. You can then define an attribute control
type as a global list. When the User Application displays the attribute for editing, the contents of the
global list are displayed in a drop-down list for the user to make a selection. By default, the directory
abstraction layer includes the global lists described in Table 3-4.
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Table 3-4 Directory Abstraction Layer Default Global Lists

List Name Description

Delegate Relationship Defines the relationships that can be selected when making a Delegate
Assignment by relationship. The contents of this list display in a drop-
down list box. The values can only be DN attributes from the User entity.

Email Notification Types Represents the type of e-mail notification that a user wants to receive
when involved in proxy/delegate processing of resource requests. Types
are locked.

WARNING: Do not edit these values.

This is used by the Preferred Notification attribute of the user entity.

Provisioning Category Defines the set of categories that organize provisioned resources
(entitlements) and provisioning requests. The categories in this list
display in:

+ Designer: Provisioning request definition editor plug-in
+ iManager: Provisioning Request Configuration plug-in
+ User Application: Requests and Approvals tab

Resources Category Defines the set of categories that organize resources. The categories
are displayed in:

+ Designer: Role Plug-in

+ User Application: Roles and Resources tab

Roles Category Defines the set of categories that organize roles. The categories are
displayed in:

+ Designer: Role plug-in

+ User Application: Roles tab

NOTE: You cannot delete these lists or change the key values for the lists. Except for the Email
Notification types, you can add and remove items and change existing values and labels.

To create a new global list:

1 Launch the New List Wizard in one of these ways:
From Designer’s menus:

+ Select File > New > Provisioning, select Directory Abstraction Layer List, then click
Next.

When launched from the File menu, the dialog box contains fields not displayed when
launched in other ways.

+ Select DAL > New > List.
From the Provisioning view:
+ Right-click the Lists node, then select New.
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From the directory abstraction layer editor:

+ Click New List.

+ Right-click the Lists node, then select Add List.
The New List dialog box displays.

Mew List

Specify project and application For the new list as well as the key for the
new lisk,

Identity Manager Project: |TestF‘rDject

EREN

Prowisioning Application: |User Application

Lisk Key: |

Display Label; |

| | Cancel

2 Fill in the fields as follows:

Field Description

Identity Manager Project and Provisioning Select the Identity Manager project and

Application provisioning application where you want to add
the list.

NOTE: These fields display when you launch the
wizard from the File menu.

List Key The unique identifier for the list.

Display Label The string used when the list is displayed in the
User Application. You can localize this label. For
more information, see Section 2.10, “Localizing
Provisioning Objects,” on page 44.

3 Click Finish.The Global Lists property page displays for editing.
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[F] Test List

Global List
Provide a user-friendly label For the list, Click '+ o add valuejlabel itemns to the lisk:
Eey: TestLisk

Display Label; | Test Lisk

s 2 =
= ¢ & B
Values Labels
valuel label1 -4

4 Fill in the fields as follows:

Field Description

Display Label The name of the list. This is the name displayed in Designer.

Labels The text for the list item to display in the User Application.

Values The list item value stored in the Identity Vault. Valid characters include

letters, numbers, and the underscore (_) character.

The following table describes the wizard’s buttons:

Button Description

= Adds a new value

..UJ

Y Moves the row up or down in the list. This order specifies how the labels are
displayed in the User Application.

¥

B Displays the localization dialog box. For more information on using the dialog

= box, see Section 2.10, “Localizing Provisioning Objects,” on page 44.

Deletes the row.

*

5 Save the project.
6 to make it available to the User Application.
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3.4 Working with Queries

The Queries node allows you to define commonly used LDAP searches that you can execute from a
request or approval form by using the DNQuery control or by calling the globalQuery() method. To
define the query, you specify the directory abstraction layer entity, the search root, the number of
rows to retrieve, and the conditions for retrieving the source entity. You can hard-code the conditions
(for example, Where LastName contains s) or specify one or more parameters that are supplied by
the user on the request or approval form.

To create a query:

1 Launch the New Query Wizard in any of these ways:
From Designer’s menus:

+ Select File > New > Provisioning. Choose Directory Abstraction Layer Query, then click
Next.

+ Select DAL > New > Query.
From the Provisioning view:

+ Right-click Query, then select Add.
From the directory abstraction layer editor:

+ Click the Add Query button.

+ Right-click Query, then select Add Query.
The New Query dialog box displays.

NOTE: When launched from the File menu, the dialog box contains fields not displayed when
launched in other ways.

B New Query E|

Newr (Query

Specify project and application For the new query as well as the display
name and key for the new query,

Identity Manager Project: | walDocDriver W
Prowisioning Application: | User Application w
Query Key:

Display Label:

Cancel

2 Fill in the fields as follows:

Configuring the Directory Abstraction Layer 67



Field What to do

Identity Manager Project and Select the correct Identity Manager project and Provisioning
Provisioning Application Application.

NOTE: This field displays when you create queries from the
File menu.

Query Key Type a unique value for the query key. This value is used in
the Expression Builder to identify the query.

Display Label Type a string to display in the directory abstraction layer
editor and Provisioning view. This value is not visible in the
Expression Builder.

3 Click Finish.
The editor creates the query and opens the property page for editing.

@ Sample Query @

General
Provide a user-friendly label For the query:
Key: SampleCiuery

Display Label: | Sample Query %?

Query Entity: | <Select an item = L3

~ Parameters
Define parameter references:

= & & B

+ Query Conditions
Provide conditions For the query entity selected above:

{4 add Condition Grouping

- Search

Provide search constraints For the query:

Search Rook: 2] @-

Search Scope: <Default> v

Max Search Entries; |0 “ | (D=use runtime setting)

4 Select a Query Entity. If the entity you want to use is not displayed, make sure it is defined in
the Entities node.

5 In the Parameters section, define one or more parameters for the query. To add parameters:
5a Click Add Row.
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~ Parameters
Define parameter references:

S
Parameter Keys Parameter Display Labels
labell b4

5b Specify a unique key and a display label for the parameter. You pass this key when calling
the globalQuery() method on a form. For more information on globalQuery(), see
“globalQuery(fieldname, key, param)” on page 340.

5c¢ Add additional parameters by repeating these steps.
6 To further refine the query, add Query Conditions.

6a Click Add Condition Grouping (a Query Entity must be selected to enable Add Condition
Grouping).

+ Query Conditions
Provide conditions For the query entity selected above:

' 4F &dd Condition Grouping

% Remove Condition Grouping =

<Select anitem W | | <3elect an ikem v O, 4

6b Use the drop-down list on the left to select an attribute. The attributes in this drop-down
are the attributes on the selected Query Entity.

6¢ Use the drop-down in the middle to select a comparison operation to perform against your
chosen attribute.

6d Use the entry on the right to specify a value to compare against your chosen attribute. You
can select a variable name by clicking Predefined Parameters to launch the Predefined
Parameters dialog box.
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B (%]

Parameters

Select one of the predefined parameters For your Figld,

“egroupnanmes

I2) [ K, H Cancel ]

If the query needs to filter on more than one attribute or condition and you want to control
the order in which the conditions are evaluated, you can define multiple conditions or
condition groups. Within a condition grouping, you specify each criterion that you want
and connect them by using the logical operations: and, or.

7 To specify multiple condition groupings, click Add Condition Groupings and make your
selections from the drop-down list boxes.

8 Define the query’s LDAP Search properties if you want to narrow the search further than
already defined for the selected entity. The query’s search root, unlike the entity search root,
does not support the use of predefined parameters. For more information, see Section 3.7.3,
“Queries Properties,” on page 87.

9 Click Save.
10 the query to make it available to the User Application.

3.5 Working with Relationships

The Relationships node allows you to define relationships between entities defined in the directory
abstraction layer. The relationships you define are used in the User Application by the Organization
Chart and in iManager for defining the members within a group.

The relationship you define can be between like entities (such as user/user) or unlike entities (such
as user/device). You can define conditions for the relationship to further refine it. For example, you
might want to create a condition that shows all Manager-Employee relationships and then refine it to
show only employees in one particular region, or show all the subordinates of a vice president
located in the eastern region.

The following relationships are defined, by default, for the User Application:

+ Group’s membership (Org Chart only)
+ Manager-Employee (Org Chart and Management)
+ User groups (Org Chart only)

A relationship can only be used by Management when the Source and Target entities are both related
to the InetOrgPerson object.
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To successfully deploy a relationship, all of the components (entities and attributes) of the
relationship must already be deployed.
1 Create a new relationship in any of these ways:
From Designer’s menus:

+ Select File > New > Provisioning. Choose Directory Abstraction Layer Relationship, then
click Next.

+ Select DAL > New > Relationship.
From the Provisioning view:

+ Right-click Relationships, then select Add.
From the directory abstraction layer editor:

+ Click the Add Relationship button.

+ Right-click Relationships, then select Add Relationship.
The New Relationship dialog box displays.

NOTE: When launched from the File menu, the dialog box contains fields not displayed when
launched in other ways.

News Relationship

Specify project and application For the new relationship as well as the
display name and key for the new relationship,

Identity Manager Project: |Project0ne

Led Lo

Prowisioning Application: |User Application

Relationship Kew: | |

Display Label; |

< Back | | Cancel

2 Fill in the fields as follows:

Field What to do
Identity Manager Project and Select the correct Identity Manager project and Provisioning
Provisioning Application Application.

NOTE: This field displays when you create relationships from
the File menu.

Relationship Key Type a unique value for the relationship key.
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Field What to do

Display Label Type the string to display when the relationship displays in
the User Application.

3 Click Finish.
The editor creates the relationship and opens the property page for editing.

- 1 H
§ | m =z |# Group's membership
=144 Entities a
ccess
C’}‘J Description Specify the bype of application which can use this relationship:
C,‘J Members [#]used by Organizational Chark
+ '\j Manager Laookup
e 'ﬂj User
+ el User Lookup
=[] Lists

Relationship

El Delegates Relationship Provide a user-friendly label For the relationship:

m Ernail notification types

El Preferred Locale key: R
El Provisioning Categary Display Label: | Group's membership %?
] request Scope
@ Queries

= @ Relationships Source Dbject Target Object
] Groun's menbership Source Entity: Group “ | Target Entity: User -
#4 Manager-Employes
#1 User groups Source Attribube: | This entity's key ~ | Target Attribute: | Group v

5 configuration

~ Conditions

Specify any additional conditions For your target attribute: e

For property definitions, see Section 3.7.4, “Relationship Properties,” on page 88.

To delete a relationship:
1 Right-click the relationship you want to delete, then click Delete.
To add a relationship condition:

1 Click Add Row.

2 Use the drop-down list box (on the left) to select an attribute. The attributes in this drop-down
are attributes on the Target Object entity.

3 Select an operator from the middle drop-down list box.
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4 Use the text field on the right to specify the comparison value to complete the condition. For
example:

¥ Manager-Employee(region)
Access
Specify the type of application which can use this relationship:

Used by Organizational Chart [CJEnable Cascading Relationship

Used by Team-Management 0 o | Maximum levels to cascads

Relationship
Provide a user-frisndly label For the relationship:
Key! UsErZIserss

Display Label: | Manager-Employesiregion) &=

Source Object Target Object
Source Enkiby: User | Targek Entiby: User L

Source Attribute: | This entity's key “ | Target Attribute: |Manager -

= Conditions

Specify any additional conditions For your target attribute: S

Reqion * | | equals + | | Latin ®

You can create a condition that filters on more than one attribute or condition and connect the
attributes by using the logical operations: and, or. The conditions are evaluated in the order in which
you define them.

3.6 Working with Configuration Settings

The Configuration node allows you to set general configuration properties for the User Application.

Table 3-5 Configuration Settings

Field Description

Default ‘My Profile’ Entity Defines the entity to display when the user clicks My Profile in the
user interface.

This field is restricted to show only entities whose object class is
user (or LDAP inetOrgPerson).

Default LDAP Naming Attributes Defines the default LDAP naming attribute if the entity’s Create
Naming Attribute is not defined.
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Field

Description

Default Management Attributes

Container Classes

The attributes used to look up members. In the My 's Work and My
's Settings pages of the User Application, the user is able to search
for members by clicking the search icon. For example:

Team Metmhber: E

The search displays the attributes specified here, for example:

Ohject Lookup S ]

Search ohject list, (example; &%, Lar®, 1D, *1)

LastMame

| ™% Search

These settings only affect the lookups performed by Managers.
The User Application administrator sees only First Name and Last
Name.

This provides the Create User or Group action with the contents of
a selection list of container classes. The user selects a container
from the selection list as the location for the newly created object.

3.7 Directory Abstraction Layer Property

Reference

The section provides definitions for the properties for the following abstraction layer nodes:

*

*

*

*

Section 3.7.1, “Entity Properties,” on page 74
Section 3.7.2, “Attribute Properties,” on page 78
Section 3.7.3, “Queries Properties,” on page 87
Section 3.7.4, “Relationship Properties,” on page 88

3.7.1 Entity Properties

You can set the following kinds of properties on entities:

+ “Entity Access Properties” on page 75

+ “Entity General Properties” on page 75

+ “Entity Auxiliary Properties” on page 75

+ “Entity Search Properties” on page 76
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+ “Entity Create Properties” on page 77
+ “Entity Password Management Properties” on page 77
+ “Using Predefined Parameters” on page 77

Entity Access Properties

Access properties control how the User Application interacts with the entity.

NOTE: You can also access the access properties by selecting DAL > Set Global Access.

Table 3-6 Entity Access Properties

Property Name Description
Create When selected, this object can be created by the User Application.
Edit When deselected, this object cannot be changed by the User Application

regardless of the underlying ACLs.

When selected, this object is editable, but the Identity Vault ACLs are used
to determine this.

View When selected, this object can be displayed by the User Application.

Remove When selected, this object can be deleted by the User Application.

Entity General Properties

Table 3-7 Entity General Properties

Property Name Description

Key The unique identifier for this entity. It defines the way the User Application
references this object. It is defined when the entity is created and cannot be
modified after the entity is created.

Display Label Defines how the object is shown in the user interface.

Class Name The eDirectory object class name.

LDAP Name The LDAP object class name.

Include in Search When selected, this entity is searchable in the User Application. Entities used in

queries by identity portlets (such as Entity Search List or Entity Org Chart) must
be selected (True).

Entity Auxiliary Properties
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Table 3-8 Entity Auxiliary Properties

Property Name Description

Auxiliary Classes A list of zero or more auxiliary classes for this entity. If you are adding
auxiliary classes, you are prompted to define:

+ The auxiliary class by selecting from the list of those available

* Whether it is searchable. Setting searchable to True applies a filter to
LDAP searches that involve directory abstraction layer relationships.
For example, if you added an aux class to the user entity and
specified that the aux class was searchable, the Org Chart (using the
manager-employee relationship) would display only the employees
that have the aux class.

* Whether to Add Always. When True (selected), the object class is
automatically added when the entity is modified in the User
Application. Maodification includes create or update operations. When
False, the object class is only added if an attribute associated with the
auxiliary class is modified.

Entity Search Properties

Table 3-9 Entity Search Properties

Property Name Description

Search Container The distinguished name of the LDAP node or container where
searching starts (the search root). For example:

ou=sample,o=ourOrg

You can browse the Identity Vault to select the container, or you
can use one of the predefined parameters described in “Using
Predefined Parameters” on page 77.

Search Scope Specifies where the search occurs in relation to the search root.
Values are:

<Default>: This search scope is the same as selecting Containers
and subcontainers.

Container: The search occurs in the search root DN and all
entries at the search root level.

Container and subcontainers: The search occurs in the search root
DN and all subcontainers. This is the same as selecting
<Default>.

Object: Limits the search to the object specified. This search is
used to verify the existence of the specified object.

Search Time Limit [ms] Specify a value in milliseconds or specify 0 for no time limit.

Max Search Entries Specify the maximum number of search result entries you want
returned for a search. Specify 0 if you want to use the runtime
setting. Recommendations: Set it between 100 and 200 for
greatest efficiency. Do not set it over 1000.
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Property Name

Description

Perform Automatic Query

When selected, performs an automatic query of the entity and
presents the results in a selectable list. Do not choose this option
if the data returned will be a large number because it forces the
user to scroll through a large result set.

When not selected, allows the user to specify the search criteria
for the entity query, then presents the results in a selectable list.

Entity Create Properties

Table 3-10 Entity Create Properties

Property Name

Definition

Create Container

Create Naming Attribute

LDAP attribute

Create Naming Label

The name of the container where a new entity of this type is created.

You can browse the Identity Vault to select the container, or you can use
one of the predefined parameters described in “Using Predefined
Parameters” on page 77.

If you do not specify this value, then the Create portlet prompts the user to
specify a container for the new object. The portlet uses the search root
specified in the entity definition as the base and allows the user to drill
down from there. If there is no search root specified in the entity definition
then it uses the root DN specified during the User Application installation.

The naming attribute of the entity. It is the relative distinguished name
(RDN). This value is only necessary for entities where the access
parameter Create is selected.

The LDAP attribute for the Create Naming Attribute.

Display label displayed in the User Application for the Create Naming
Attribute.

Entity Password Management Properties

Table 3-11 Entity Password Management Properties

Property Name

Definition

Password required when entity is created If the password attribute is required, set this value

to True (selected) to ensure that one is required by
the Create portlet. If a password is required, then
you cannot create this entity in a workflow.

Using Predefined Parameters

The directory abstraction layer editor allows you to use predefined parameters for certain values.
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Table 3-12 Predefined Parameters

Predefined Parameter Description

%driver-root%

%user-root%

%group-root%

Represents the Provisioning Driver DN. This value is specified during
the User Application configuration during installation or a later
configuration. It is stored in the User Application’s realm configuration.

Represents the User Container DN. This value is specified during the
User Application configuration during installation or a later
configuration. It is stored in the User Application’s realm configuration.

Represents the Group Container DN.This value is specified during the
User Application configuration during installation or a later
configuration. It is stored in the User Application’s realm configuration.

3.7.2 Attribute Properties

You can set the following kinds of properties on attributes:

+ “Attribute Access Properties” on page 78

+ “Attribute General Properties” on page 79

+ “Attribute Default Value Properties” on page 80

+ “Attribute Ul Control Properties” on page 80

+ “Attributes and DNLookup Properties” on page 83

Attribute Access Properties

NOTE: You can set attribute access for all of an entity’s attributes by selecting DAL > Set Attribute
Access, right-clicking an entity, and selecting Set Attribute Access.

Table 3-13 Attribute Access Properties

Name

Description

Edit

Enable

When selected, this attribute can be edited/modified by the User Application. Even if
it is selected (True), the attribute might still not be editable if the underlying Identity
Vault ACLs/effective rights prevent it.

When deselected, this attribute cannot be used by the User Application. It is the
same as removing the entry from the file.
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Name Description

Hide Controls whether the Hide check box in the User Application is enabled or disabled.
The Hide check box allows users to control whether an attribute (such as a photo) is
displayed by the application.

When deselected, the Hide check box is disabled for this attribute, so the user
cannot choose to hide this attribute.

When selected, the Hide check box can be enabled in the User Application.
However, the following must also be true of the logged-in user.

+ He or she is either the owner of the attribute or a User Application
Administrator.

+ He or she has Trustee rights to update the srvprvHideAttributes attribute on the
Identity Vault.

If these requirements are not met, then the Hide check box is disabled in the
user interface even if this setting is selected (True).

TIP: When a user hides an attribute that contains an image, users who have viewed
the image might continue to see it until their browser cache is refreshed.

The Search and Hide properties are mutually exclusive. If Hide is selected (True),
Search cannot also be selected (True). If Search is selected (True), Hide cannot be
selected (True).

Multivalue Specifies whether this attribute can be multivalued, for example, a phone number.
When selected, the attribute can be multivalued.

Read When this option is selected, the User Application can query this attribute. For most
attributes this should be selected (True), but for some attributes, like password, it
should be deselected.

Require When this option is selected, the attribute must be supplied.

Search When this option is selected, the User Application can search on this attribute.
Attributes that are used in queries by identity portlets (such as Entity Search List or
Entity Org Chart) or request and approval forms must be selected.

TIP: If an attribute used in a search is also indexed in eDirectory, the search is faster.

The Search and Hide properties are mutually exclusive. If Hide is selected (True),
Search cannot also be selected (True). If Search is selected (True), Hide cannot be
selected (True).

View When this option is selected, the User Application can display this attribute. In most
cases this is selected, but for attributes like password, it should be deselected. If you
specify it in a request or approval form, view must be selected.

Attribute General Properties

Table 3-14 Attribute General Properties

Property Name Description

Key The unique identifier for the attribute.
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Property Name Description

Display Label The label that is displayed in the User Application.
Attribute Name The eDirectory name for this attribute.
LDAP Name The LDAP name for this attribute.

Attribute Default Value Properties

This value is used when an object is created via the Create identity portlet or through a workflow.
You can express the default value as a literal or an ECMAScript expression. You cannot use a
default value as part of a calculated attribute. If defined as an ECMAScript expression, it is resolved
at runtime. If you define both the literal and an expression, the expression takes precedence.

TIP: If you want the default value to be displayed by the Create portlet, you must define the access
property viewable as True (selected). If you want the user to be able to change the value, you must
set the editable property to True.

Attribute Ul Control Properties

Table 3-15 Attribute Ul Control Properties

Property Name Description

Data Type Choose a data type from the following list:

+ Binary

+ Boolean
* DN

* Integer

+ LocalizedString

NOTE: Selecting the LocalizedString Data Type causes the search to be
case-sensitive in the Ul.

+ String

¢ Time
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Property Name Description

Format Type Used by the User Application to format data. Format types include:

* None

¢ AOL IM

+ Emalil

+ Groupwise IM
+ Image

+ Phone Number
¢ Yahoo IM

* Image URL

¢ Date

+ DateTime

The Format Types are dependent on the data type. For example, a Time data
type can only be associated with Date and DateTime formats.

Configuring the Directory Abstraction Layer 81



Property Name Description

Control Type Types include:

DNLookup: Defines that this attribute contains a DN reference. Use when you
want to:

+ Populate a list with the results of a DN search among related entities.

+ Maintain referential integrity across DN referenced attributes during
updates and deletes.

+ Use the attribute in an object selector dialog box. Object selectors are used
by certain identity portlets, such as Detail, and are also available to the
form controls you can define for provisioning request and approval forms.

The User Application uses this information to generate special user interface
elements (such as an object selector), and to perform optimized searches based
on the DNLookup definition.

For more information on defining this property, see the “Attributes and
DNLookup Properties” on page 83. For more information on the object selector
dialog box for request and approval forms, see Section 5.6.2, “Working with
Object Selectors,” on page 173.

Global List: Display this attribute as a drop-down list whose contents are defined
in a file outside of this attribute definition. Click Go to list to access the Global
List editor for the selected list.

For more information, see Section 3.3, “Working with Lists,” on page 63.

Local List: Display this attribute as a drop-down list whose contents are defined
with this attribute. To define a local list:

1. With the attribute selected, set the control type to Local List.

 UI Control
Specify any Formatting or special controls used in displaving the attribute;

Daka Type: String -
Formak Type: | <None > b
Control Type: | Local List w

= Local List

+ ¢ & 8
Yalues Labels
waluel labell ¥

2. Use the buttons to add or remove list items. Use the up-arrow and down-
arrow buttons to change the position of the item in the list.

In the Value column, type the value to write to the Identity Vault. It can
include letters, numbers, and the underscore (_) character.

3. Inthe Labels column, type the text you want displayed in the user
interface.

Range: Use the Range control type with Integer data types to restrict user input
to a sequential range of values. Define the range’s start and end values.
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Attributes and DNLookup Properties
When you define an attribute as a DNLookup control type, it means that:

+ This attribute can be used in an object selector dialog box that allows users to select from a list
of possible values when searching on this attribute.

+ When this attribute is created, populated, or deleted through the User Application, an attribute
on a related entity is updated appropriately depending on the user action (create, delete, update)
to maintain referential integrity.

DNLookups for Object Selectors

The DNLookup Display properties for a particular attribute define the contents of the object
selectors in the User Application. Object selectors are displayed by the Identity Self-Service portlets
and in workflow request and approval forms. They provide a convenient way for users for users to
search and select objects that represent DNs (such as users or groups). The object selector displays a
drop-down list of attributes; the user can select one of the attributes and then enter search criteria for
that attribute. In this example, the user searches for groups by group description.

Figure 3-2 Sample Object Selector

[ Object Lookup - Mozilla

TS

Object Lookup T E O

Search object list: [example: a%, Lar™, 1D, ™)

Description  » “‘% search

The result of the user’s selection looks like this:
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Figure 3-3 Sample Object Selector Results

[ Object Lookup - Mozilla (=13

Object Lookup ? & _ 0O

Search object list: [example: a%, Lar™, 1D, 1)

Description » |H “‘% Search

Select an object from the list:

Description
Improve Customer Service taszk force

Information Technology

1-2of2

The DNLookup display properties control the contents of the object selector and the result set. The
object selector, shown above, displays this way because it was based on the group attribute of the
user entity. The group attribute is defined as a DNLookup control type as shown here:

Figure 3-4 Group DNLookup Definition

~ UI Control

Specify any Formatting ar special contrals used in displaying the attribute:

Data Type: |DN 4 |
Format Type: |<N0ne> v|
Contral Type: |DNLoolmp ~ |

* DNLookup Display
Select the Entity and Attributes ta display for the Lookup operation:

Loakup Entity: Group w |

Lookup Attributes

P | Description v | 4

|:| Perfarm Automatic Query

This definition also controls the way identity portlets provide a selection list of groups for a user. For
example, a user might choose to do a Directory Search to find a user in a group, but the group name
is unknown. The user would select User as the object to search for and select group as the search
criteria, as follows:
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Figure 3-5 Search Criteria

Search List &8 _0
Basic Search

Search far: | User VI

With this criteria:

CECH | [ae: S S = <

@ My Sawed Searches _@- Advanced Search

Because the members attribute is a DNLookup for the user entity, the Lookup icon displays. If the
user selects it, then a list of possible groups displays.

Figure 3-6 Object Lookup

2 Object Lookup - Microsoft Internet Explorer

-

Object Lookup & _ 8

Search object list: [example: &%, Lar™, 10, *r]

Dezcription V| | | "‘% Learch

Select an object from the list
Description

focounting

Executive fihanagement

Human Resources

Improve Customer Service task force
Information Technology

Marketing

Salez

1-Faof?
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When the user picks a group, then he or she can select a group from the list and all of the members
of that group are displayed.

NOTE: When the Perform Automatic Query property is not selected (False), the object selector is
not populated when first displayed to the user and the user must enter selection criteria. The example
above illustrates the object selector that displays when the Perform Automatic Query property is
selected (True).

DNLookups for Referential Integrity

DNLookups for updates and synchronization are important because LDAP allows group
relationships to map in both directions. For example, your data might be set up so that:

+ The User object contains a group attribute. The group attribute is multi-valued and lists all of
the groups to which a user belongs.

+ The Group object contains a user attribute. The user attribute is multi-valued and lists all of the
users that belong to the group.

This means that you can have an attribute on the user object that shows all the groups a user belongs
to, and on the Group object you have a DN attribute that includes all the members of that group.

When the user requests an update, the User Application must honor the relationships and ensure that
the target and source attributes are synchronized. In the DNLookup, you specify both attributes that
must be synchronized. You can use this technique to provide synchronization between any objects
that are related not just group structural objects. Create this kind of DNLookup control type by
specifying the advanced DNLookup properties described in the DNLookup Relational Integrity
properties reference.

DNLookup Property Reference

Table 3-16 DNLookup Display Properties

Property Name Description

Lookup Entity The name of the entity to search. For example, suppose that
the User entity contains an attribute for Manager. To populate
that field, you'd need to know which users are Managers.

Lookup Attributes Choose one or more attributes to display when a search is
performed.
Perform Automatic Query Defines how the Lookup Attributes are displayed.

¢ When this option is selected, the form or portlet
performs an automatic query of the entity and presents
the results in a selectable list. This option is not
recommended if a large amount of data can be returned
because it forces the user to scroll through a large result
set.

+ When this option is deselected, allows the user to
specify the search criteria for the entity query, then
presents the results in a selectable list.

86  User Application: Design Guide



Table 3-17 DNLookup Detail Properties

Property Name Description

Detail entity The key of the entity whose details you want displayed if the
user requests more information by clicking a hypertext link in
the User Application. When you define a DNLookup, the
identity portlets are able to provide a hypertext link that allows
users to display the details of the linked object.

The DNLookup Relational Integrity properties are used for synchronizing data between two objects
such as groups and group members.

Table 3-18 DNLookup Relational Integrity Properties

Property Name Description

Source Attributes to Update Name of the attribute to update. The attribute must contain a DN
reference to the Target Attributes to Update. This is required to
synchronize attributes on two different objects.

Target Attributes to Update Name of the attribute that must be updated along with the Source
Attributes to Update. This is an LDAP attribute name. This is
required to synchronize attributes on two different objects. The
attribute must contain a DN reference.

Target Auxiliary Classes Needed, if Name of the auxiliary class that contains the Target Attributes to
any Update.

3.7.3 Queries Properties

You can set the following kinds of Queries properties:

+ “Queries General Properties” on page 87
+ “Query Parameters Properties” on page 88
+ “Query Search Properties” on page 88

Queries General Properties

Table 3-19 Queries General Properties

Property Name Description

Key A unique value for the query key. This value is used in the Expression Builder
to identify the query. The key is specified at the query creation time. It cannot
be modified after the query is created.

Query Entity Select an entity from the drop-down list box. The resulting LDAP search is on
this entity.
Display Label Type a string to display in the directory abstraction layer editor and

Provisioning view. This value is not visible in the Expression Builder.
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Query Parameters Properties

Table 3-20 Queries Parameters Properties

Property Name Description

Parameter Keys A unique identifier for the key. You pass this key when calling the
globalQuery() method on a form.

Parameter Display Labels A label to identify the key.

Query Search Properties

If left blank, the query search properties default to the search properties specified for the selected
entity. Specify the query search properties to further refine the search scope already defined for the
entity. You cannot specify predefined parameters (for example,%user-root%) in the query’s search
properties.

Table 3-21 Query Search Properties

Property Name Description

Search Root Specifies the location in the LDAP tree where the LDAP search defined by
the query begins.

Search Scope Specifies where the search occurs in relation to the search root. Values
are:

<Default>: This search scope is the same as selecting Containers and
subcontainers.

Container: The search occurs in the search root DN and all entries at the
search root level.

Container and subcontainers: The search occurs in the search root DN and
all subcontainers. This is the same as selecting <Default>.

Object: Limits the search to the object specified. This search is used to
verify the existence of the specified object.

Max Search Entries Specify the maximum number of search result entries you want returned for
a search. Specify 0 if you want to use the runtime setting.
Recommendations: Set it between 100 and 200 for greatest efficiency. Do
not set it over 1000

3.7.4 Relationship Properties

Relationship properties include:

+ “Relationship Access Properties” on page 89
+ “Relationship Properties” on page 89
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Relationship Access Properties

Table 3-22 Relationship Access Properties

Property Name

Description

Used by Organizational Chart

Used by Management

When selected, this relationship can be used by the Org Chart
portlet.

When selected, this relationship can be used to define the
provisioning members in iManager.

For example, if Used by Management is selected for the manager-
employee relationship, then the provisioning application administrator
can use this relationship to define the members as all users that
report to the manager.

If Enable Cascading Relationship is selected, then the can include
several levels within the organization. You define the number of
levels via Maximum Levels to Cascade.

Relationship Properties

Table 3-23 Relationship Properties

Property Name

Description

Key

Display Label

Source Entity

Source Attribute

The read-only unique identifier for the relationship.

TIP: You specify this value in the Org Chart Portlet preference sheet.

Specify a name to display when this relationship is displayed in the User
Application. For example, this value is displayed when users click
Choose Org Chart from the Detail portlet.

Click Localize to provide the translation for the display label text.
Choose an entity from the drop-down list.

The entity that you choose becomes the parent or source object in the
organization chart hierarchy. In a Manager-Employee relationship, the
Source Entity is User. For a Group-Member relationship, the source entity
is Group.

Directory abstraction layer requirements: The entities in this list are a
subset of the entities defined in the directory abstraction layer. Source
entities must have the view access property selected (True).

Choose an attribute from the drop-down list.

This attribute is used to find matching target entities. When the value of
this attribute matches a corresponding value on an attribute of the target
entity (see Target Attribute below), then a relationship can be established.

Directory abstraction layer requirements: This list of attributes is
populated using the selected Source Entity’s attributes. It includes any
attributes that are searchable and readable.
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Property Name Description

Target Entity Choose an entity for the child object in the hierarchy. In a Manager-
Employee relationship, it is user.

This entity must contain the attribute that is related to the Source
attribute.

Target Attribute Choose the attribute that matches the Source Attribute.

This is the target entity’s attribute used to find matching source entities.
When the value of this attribute matches a corresponding value on the
source entity (see Source Attribute above), then a relationship can be
established.

NOTE: The Org Chart portlet does not fully support dynamic groups; you cannot define a dynamic
group as the Source entity, but you can define a dynamic group as the target entity.
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Configuring Provisioning Request
Definitions

A provisioning request is a user or system action that initiates one or more provisioning workflows.
These workflows can be used to grant or revoke resources or roles, or perform attestation processes.
You use the provisioning request definition editor to create and deploy provisioning requests to the
User Application driver. This section includes information about the provisioning request definitions
shipped with the system and how to create new provisioning request definitions. It include the
following sections:

+ Section 4.1, “About Provisioning Request Definitions,” on page 91

+ Section 4.2, “Using the Provisioning Request Definition Editor,” on page 92
+ Section 4.3, “Provisioning and Workflow Example,” on page 109

4.1 About Provisioning Request Definitions

Provisioning request definitions are directory objects that encapsulate the business rules for granting
or revoking a corporate resource or role, and binding the corporate resource or role to a workflow.
Provisioning request definitions can also be used to launch attestation workflows. They are used in
the User Application to support:

+ Resource requests on the Requests & Approvals tab

Resource requests allow users to request access to resources such as accounts, applications,
servers, and so forth. Novell provides a read-only resource-oriented provisioning request
definition named Resource Approval.

For information about customizing the existing definition or writing your own resource based
provisioning request definitions, see Section 6.7, “Guidelines for Creating Resource Based
Workflows,” on page 213.

+ Role assignment requests on the Roles tab.

Role assignment requests allow users to request roles that grant them permissions to resources
and not to the resources themselves. Novell provides these two read-only role-oriented
provisioning request definitions:

+ Role Approval: Manages role requests.

+ SoD Conflict Approval: Manages role requests that result in Separation of Duties (SoD)
conflict overrides.

For information about customizing the existing definitions or writing your own roles based
provisioning request definitions, see Section 6.6, “Guidelines for Creating Roles Based
Workflows,” on page 203.

+ Attestation process requests on the Compliance tab.

Attestation process requests are used by Compliance Administrators and Attestation Officers to
submit requests for attestation workflows. These workflows allow users to verify their own
user profile information, to allow authorized users to verify the violations and exceptions to
SoD constraints, or to verify role and user assignments.
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Designer provides these two attestation type provisioning request definitions:

+ Attestation Report: Manages the attestation process that allows users to verify the
violations and exceptions for a set of SoD constraints.

+ Attestation User Profile: Manages the attestation process that allows users to confirm that
their user profiles contain accurate information.

Attestation type provisioning request definitions are not editable within Designer. You cannot
define or use custom provisioning request definitions for attestation, and they are not visible on
the Requests & Approval tab.

You use Designer to define the trustees for the attestation process requests, to deploy the
provisioning request definitions, and to localize the text users see during the approval process.
For information on localizing attestation provisioning request definition text, see Section 2.10,
“Localizing Provisioning Objects,” on page 44.

4.2 Using the Provisioning Request Definition
Editor

The provisioning request definition editor allows you to create provisioning request definitions that
bind corporate resources or roles to a workflow. The provisioning request definition editor includes
the following tools:

*

*

*

Overview tab: Used to define the basic characteristics of the provisioning request.

Workflow tab: Used to define the associated workflow by configuring activities and flow
paths.

Form tab: Used to define the request and approval forms that the user interacts with in the
Requests & Approvals tab.

Signature Declarations tab: Used to define the Digital Signature declarations.

For provisioning request definitions that are not based on roles, you can use a provisioning request
template to create your definitions. The templates model some common workflow design patterns.
However, if you want complete control over the behavior of your workflows, you can create your
own custom provisioning request definitions.

*

*

Section 4.2.1, “Creating a Provisioning Request Definition,” on page 92

Section 4.2.2, “Starting the Provisioning Request Definition Editor,” on page 93

Section 4.2.3, “Creating a Provisioning Request Definition By Using a Template,” on page 95
Section 4.2.4, “Creating a Custom Provisioning Request Definition,” on page 101

Section 4.2.5, “Creating a Roles Based Provisioning Request Definition,” on page 102
Section 4.2.6, “Modifying Settings of a Provisioning Request Definition,” on page 103

4.2.1 Creating a Provisioning Request Definition

This section describes how to create both provisioning requests that are based on roles and
provisioning requests that are not based on roles by using the following methods:

*

*

From a template (not supported for roles based provisioning request definitions).
From a copy of an existing provisioning request definition.

+ As a custom provisioning request definition.
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When possible, you should use a template or a copy of an existing definition because it saves you
time, and allows you to make targeted changes to an existing provisioning request definition.
However, if no existing provisioning request definition resembles new work that you want to do,
you can create a custom provisioning request.

The following table describes the steps for defining a provisioning request.

Table 4-1 Basic Steps for Defining a Provisioning Request

Task Action For More Information
1 Create a provisioning request definition. Depending on what you want to
create, see:

+ “Creating a Provisioning
Request Definition By Using a
Template” on page 95

+ “Creating a Custom Provisioning
Request Definition” on page 101.

+ “Creating a Roles Based
Provisioning Request Definition”
on page 102

+ “Modifying Settings of a
Provisioning Request Definition”
on page 103

2 Create the request and approval forms. See Chapter 5, “Creating Forms for a
Provisioning Request Definition,” on
TIP: Creating the forms before the workflow simplifies Page 115
the process of mapping the form fields to the
application data.

3 Create the workflow diagram by adding activities to the See Chapter 6, “Creating the
workflow diagram and connecting them with flow Workflow for a Provisioning Request
paths. Definition,” on page 183

4 Configure the activities and flow paths by specifying See Chapter 7, “Workflow Activity
the properties, data item mappings, and e-mail Reference,” on page 225

notification settings for the actvities. Then define the
semantics for the flow paths.

4.2.2 Starting the Provisioning Request Definition Editor

1 Open the Provisioning view and double-click the Provisioning Request Definitions node.

Designer displays the provisioning request definitions tree containing nodes for the default
provisioning definition request definition categories of Accounts, Attestations, Entitlements,
Groups, Roles, and Uncategorized.

= E) Provisioning Request Definitions
E,:. Accounts
+ E.:. Attestations
+ E,:. Entitlements
E,:, Sroups
+ E,:. Rales
E,:. Uncateqorized
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These default categories are defined by the directory abstraction layer Provisioning Category
list. For information on managing categories, see Section 3.3, “Working with Lists,” on

page 63.

The installed templates are available in the Entitlements node, and the default role provisioning
request definitions are available in the Roles node.

2 Use the Provisioning view pane to navigate the provisioning request definition categories. The
right-click menu is available from the top-level node or when you select an existing
provisioning request definition. You cannot create a provisioning request definition by
selecting a category node.

3 Double-click a provisioning request definition to open it in the editor in the right pane.

[ ] Template2Farallelapproval_TA &2 -0
Provisioning Request Definition Details -
Identifier (CM): Template2ParallelApproval _TA
Display Mame: | fremplate2ParallelApproval_TA B
Description: Two Step Parallel Approval (Timeout Approves) =
Category: Entitements w
Status: Template w
Flow Strategy: | Single Flow w
Process Type: Mormal L3
Motify participants by E-Mail
[ restrict View
Generate Comments
[ set Default Completion Status to Approved
Trustee rights: &
Trustee DN
v
Qverview .~ Workflow | Forms | Signature Dedarations
For details on using... See
Overview tab Section 4.2.6, “Modifying Settings of a Provisioning Request
Definition,” on page 103.
Workflow tab Chapter 6, “Creating the Workflow for a Provisioning Request
Definition,” on page 183.
Forms tab Chapter 5, “Creating Forms for a Provisioning Request Definition,”
on page 115.
Signature Declarations Section 6.11, “Configuring Digital Signature Support,” on page 222.

Provisioning request definitions are stored locally in the Provisioning\AppConfig\
RequestDefs directory within your workspace.
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4.2.3 Creating a Provisioning Request Definition By Using a

Template

1 Launch the Create A New PRD wizard in one of these ways:

+ From the Provisioning
choose New.

+ From the Provisioning

view, right-click the Provisioning Request Definitions node and

view, click a User Application or provisioning request container,

then select Insert > Provisioning Request Definition.

+ Select File > New > Provisioning > Provisioning Request Definition. Choose
Provisioning Request Definition, then click Next.

The first page of the Create

x

Specify the basic information of the

Give the PRD a CM name, a display name, and a description,

a New PRD Wizard is displayed.

Provisioning Request Definition.

Identifier (CN): ||

Display Marme: |

Description: |

= Back [dExt = | Eimist I Cancel

2 Fill in the fields as follows:

Field

Description

Identifier (CN)

Display Name

Description

The CN (common name) identifier for the provisioning request
definition. The name cannot be longer than 64 characters.

The display name for the provisioning request definition. This is the
name that is displayed in the Provisioning view.

A description of the provisioning request definition.

3 Click Next. The next page of the wizard is displayed.
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& Create a new PRD

Choose the workflow template for this Provisioning Request Definition.

[™ Create a provisioning request definition using one of the templates

Available Templates: Description:

TemplateZParalleldpproval _Ta -
TemplatezParallelapproval _TD
TemplatezSerialapproval _TaA
TemplateZSerialapproval _TD
Template3Parallelapproval _TA
Template3Paralelapproval _TD
Template3Serialapproval _TaA
Template3Serialbppraval _TD
Template4Parallelapproval _TA
Template4Parallelapproval _TD
Template4Serialapproval _TaA
Template4Serialapproval _TD
TemplateSParallelapproval _TA LI

Mext = | Einish I Cancel |

4 Select Create a provisioning request definition using one of the templates, then select the

desired template (for example, TemplateSingleApproval_TA) from the Available Templates
list, then click Next.

You use the next panel of the wizard to specify the provisioning request definition’s category
and trustees (the users, groups, or containers) who can access the provisioning request
definition after it is deployed.

@ Create a new PRD P§|

Specify the details of the Provisioning Request Definition.

Categaory:

Motify participants by E-Mail
Trustee rights:
TE g %

Trustee DM
admin, novell

@ Finish ] [ Caniel

5 Select a category from the list.

6 Select Notify participants by e-mail if you want approvers to be notified by e-mail about
pending approval tasks, and also want initiators to be notified by e-mail of workflow
completion. If Notify participants by e-mail is not selected, users must look at the Requests and
Approvals tab in the User Application for notifications about tasks.

7 Click the plus (+) icon to add a trustee.
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10

11

Designer displays a panel that allows you to browse the Identity Vault to select a trustee. You
can select a user, group, or container. If you cannot connect to the Identity Vault, you can type
trustee DNs directly in the Trustee DN field.

Select the trustee, then click OK.

Designer returns you to the previous panel. If desired, add additional trustees by repeating the
previous step.

When you have finished adding trustees, click Finish.

Designer displays the Provisioning Request Definition Details panel on the Overview tab (see
Section 4.2.6, “Modifying Settings of a Provisioning Request Definition,” on page 103).

Click the Workflow tab. The Workflow view is displayed.

|-| Sample £ =g
Palette 3
Q Select
& st _ Marquee
‘ | FlowPath
fo‘rrward = Activities i
a Single Approval & Start
a Approval
V' appioved  denied i ton
LY Y
15 Logfor approval activity 15 Log finsh deried Branh
‘ \ Merge
fanward 3| Condtion
fovrwar 4 ol )
j Entitlement Provisioning Activity ﬁ Mepping
“farward ;J Warkflow Status
@ E-Mail
- Rale Bindin
Pl Finish i 9

=] Role Request

}'\‘. Start Workfow

fh Finish

& Intearation

|~ Prawisioning *
j Entitlement

D?; Entity

Owerview iorkflow . Forms | Signature Declarations

The provisioning request definition template includes some default values that you must
customize for your environment. For example, the Entitlement Provisioning Activity contains
placeholder values for several data item mapping properties. You need to replace the
placeholder values with the actual values for your provisioning request.

Click the Entitlement Provisioning activity, then click the Data Item Mapping tab.
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¥4 Finish

Overview |workflow Forms|

Emnail Motification | Palicy Set | Data Flow mroperties | =0
Source Expression | Targek | [Drat:
recipient dn skrir
'cn=IDYAULT, cn=VYalueAdder, cn=spitset, o=acme' DirsML-Entitlement-Dr skrir
' Dir#ML-Entitlemnent-Action skrir
*{enter Entitlernent param here}' Dir¥ML-Entitlernent-Parameter skrir
‘brue’ Dir#ML-Entitlement-Multidaluesliowed | bool

12 Double-click in the Source Expression field to display the DirXML-Entitlement-DN target field,
then click the button that appears in the field to display the ECMA expression builder.

See Chapter 9, “Working with ECMA Expressions,” on page 321 for information about the
ECMA expression builder.

13 Use the ECMA expression builder to replace the placeholder expression with an expression
that specifies the entitlement that you want to provision with this provisioning request.

14 Replace the placeholder expression in the Source Expression field for the DirXML-Entitlement-
Parameter.

15 Click the Forms tab and customize the forms for the provisioning request to meet your needs.

See Chapter 5, “Creating Forms for a Provisioning Request Definition,” on page 115.The
template includes predefined request and approval forms. You might want to add additional
forms, or add or remove form controls.

16 Click the Workflow tab and customize the properties of the workflow to your needs.

See Chapter 6, “Creating the Workflow for a Provisioning Request Definition,” on page 183
and Chapter 7, “Workflow Activity Reference,” on page 225.

For more information about the preconfigured templates, see the following:

+ “About the Installed Templates” on page 98
+ “About the Installed Templates and Flow Strategy” on page 101

About the Installed Templates

Identity Manager ships with a set of preconfigured provisioning request definitions and workflows.
You can use these as templates for building your own provisioning system. To set up your system,
you define new objects based on the installed templates and customize these objects to suit the needs
of your organization.

The installed templates let you determine the number of approval steps required for the request to be
fulfilled. You can configure a provisioning request to require from zero to five approval steps.

You can also specify whether you want to support sequential or parallel processing, and whether you
want to approve or deny the request if the workflow times out during the course of processing.

The following table lists the templates included with Identity Manager.
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Table 4-2 Preconfigured Provisioning Request Definitions and Workflows

Template

Description

Self Provision Approval

One Step Approval (Timeout Approves)

Two Step Sequential Approval (Timeout
Approves)

Three Step Sequential Approval (Timeout
Approves)

Four Step Sequential Approval (Timeout
Approves)

Five Step Sequential Approval (Timeout
Approves)

One Step Approval (Timeout Denies)

Two Step Sequential Approval (Timeout Denies)

Three Step Sequential Approval (Timeout
Denies)

Four Step Sequential Approval (Timeout Denies)

Allows a provisioning request to be fulfilled without any
approvals.

Requires a single approval for the provisioning request
to be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires a single approval for the provisioning request
to be fulfilled. If an activity times out, the workflow
denies the request.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports sequential processing.

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the workflow
denies the request.

This template supports sequential processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports sequential processing.
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Template

Description

Five Step Sequential Approval (Timeout Denies)

Two Step Parallel Approval (Timeout Approves)

Three Step Parallel Approval (Timeout
Approves)

Four Step Parallel Approval (Timeout Approves)

Five Step Parallel Approval (Timeout Approves)

Two Step Parallel Approval (Timeout Denies)

Three Step Parallel Approval (Timeout Denies)

Four Step Parallel Approval (Timeout Denies)

Five Step Parallel Approval (Timeout Denies)

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports sequential processing.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports parallel processing.

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the workflow
denies the request.

This template supports parallel processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports parallel processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports parallel processing.
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About the Installed Templates and Flow Strategy

By default, provisioning request definition templates use the Single Flow flow strategy. The
templates assume that the recipient is a user DN. If you change the flow strategy, you must modify
the template. If you change the flow strategy to:

+ Flow per member: Remove the recipient reference from the request form.

+ Single flow provision members: Remove the recipient from the request form and add logic to
determine the addressee for the approval activity. The templates assume the recipient is a user
DN, so you must determine if the recipient is a user or group DN. You can use the IDVault
isGroup(String dn) method to determine if the DN is a group. If the recipient is a group DN,
you must provide logic for assigning the approval activity addressee.

4.2.4 Creating a Custom Provisioning Request Definition

If no existing provisioning request definition resembles the new work that you want to do, then you
need to build a custom provisioning request definition.You can still save time and effort by re-using
forms from other workflows.

NOTE: The procedure in this section does not use roles. To create a custom roles based
provisioning request definition, see Section 4.2.5, “Creating a Roles Based Provisioning Request
Definition,” on page 102

1 Create the basic information for a new provisioning request definition (see Section 4.2.3,
“Creating a Provisioning Request Definition By Using a Template,” on page 95). In step Step 4
on page 96, do not select Create a provisioning request definition using one of the templates,
and do not select a template. When you are finished, the Overview tab for the new provisioning
request is displayed.

2 Create the forms for the provisioning request definition. Defining forms before you create the
workflow topology ensures that data bindings can be set up automatically for each activity
when you create activities.

To create the forms, see Section 5.3, “Creating Forms,” on page 122.
3 Click the Workflow tab and create the workflow topology.

You create the topology of a workflow by creating and linking activities into the desired
workflow pattern, and by assigning rules to the flowpaths between activities. For information
about creating a workflow topology, see Chapter 6, “Creating the Workflow for a Provisioning
Request Definition,” on page 183.

4 Specify the details (properties, data item mappings, e-mail notification) for each workflow
activity.

To specify workflow activity details, see Chapter 7, “Workflow Activity Reference,” on
page 225.

5 Configure the flowpaths between workflow activities.
To configure flowpaths, see Section 6.4, “Configuring Flow Paths,” on page 193.
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4.2.5 Creating a Roles Based Provisioning Request Definition

Designer supplies two Roles Based provisioning request definitions that you should use as a basis
for your custom roles based provisioning request definitions. They are:

+ Role Approval

+ SoD Conflict Approval

To create a copy and customize its contents:

1 From the Provisioning view, open Roles in the Provisioning Request Definitions node.

2 Select one of the roles-based provisioning request definition (depending on which type of
approval you want to create), right-click, then select Create From.

+ Role Approval: Choose this for role requests.
+ SoD Conflict Approval: Choose this for SoD conflict approval requests.
Designer displays the Create a New PRD Wizard.

E.hl:reate anew PRD
Specify the basic information of the Provisioning Request Definition.
Give the PRD a CM name, a display name, and a description,
Identifier (CN): |
Display Marme: |
Description: |
(7) = Back Mdexk = | Einiish I Cancel

3 Fill in the fields as follows:

Field Description

Identifier (CN) The CN (common name) identifier for the provisioning request
definition. The name cannot be longer than 64 characters.

Display Name The display name for the provisioning request definition. This is the
name that is displayed in the Provisioning view.

Description A description of the provisioning request definition.

4 Click Next. Designer displays the following dialog box.
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@ Create a new PRD

Specify the details of the Provisioning Request Definition.

Categaory:
[ motify participants by E-Mail
Trustee rights: R

Trustee DM

@ Finish ] [ Caniel

5 Specify Roles for the category.

6 Select Notify participants by e-mail if you want approvers to be notified by e-mail about
pending approval tasks, and also want initiators to be notified by e-mail of workflow
completion. If Notify participants by e-mail is not selected, users must look at the Roles tab in
the User Application for notifications about tasks.

7 (Optional) Click the plus (+) icon to add a trustee.

Designer displays a panel that allows you to browse the Identity Vault to select a trustee. You
can select an individual trustee or a group.If you cannot connect to the Identity Vault, you can
type trustee DNs directly in the Trustee DN field.

8 (Optional) Select the trustee, then click OK.

Designer returns you to the previous panel. Add additional trustees by repeating the previous
step.

9 Click Finish.

Designer displays the Provisioning Request Definition Details panel on the Overview tab (see
Section 4.2.6, “Modifying Settings of a Provisioning Request Definition,” on page 103).

For more details on defining the associated workflow, see Section 6.6, “Guidelines for Creating
Roles Based Workflows,” on page 203.

4.2.6 Modifying Settings of a Provisioning Request Definition

You use the Overview tab to define the basic information about the provisioning request definition
(for example, the name of the provisioning request definition, the category to which it belongs, and
who can access it).

+ “Modifying Basic Settings” on page 104

+ “Modifying Properties of Attestation or Roles Based Provisioning Request Definitions” on
page 108
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Modifying Basic Settings

Figure 4-1 Overview Tab
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The following table describes each property that you can configure on the Overview tab.

Table 4-3 Overview Properties

Field

Description

Identifier (CN)

Display Name

Description

Category

Displays the CN (common name) of the provisioning request definition. The CN
cannot be changed.

Specifies the display name of the provisioning request definition. This is the name
that is displayed to the user in Designer and Identity Manager.

Specifies the description of the provisioning request definition.

Specifies the category to which the provisioning request definition belongs from
the list of Provisioning Categories defined in the directory abstraction layer. The
Provisioning view displays the provisioning request definitions by categories.
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Field Description

Status Specifies the status of the provisioning request definition:

Active: Select this option to make the provisioning request definition available for
use in the User Application.

Inactive: Select this option to make the provisioning request definition
temporarily unavailable for use in the User Application. You can use this option
when you want keep the roles of the person who develops the provisioning
request definition separate from the person who activates the provisioning
request definition. For example, a developer could be responsible for marking the
provisioning request definition as Inactive, and an administrator could be
responsible for changing the status to Active.

Template: Select this option if you want to use this provisioning request definition
as the basis for other provisioning request definitions. Templates are not available
for use in the User Application.

Retired: Select this option to mark the provisioning request definition as
permanently unavailable for use in the User Application (you can still change the
status of the provisioning request definition at any time). This status provides a
way of keeping a historical record of a provisioning request definition that is no
longer in use.

Flow Strategy Specifies the flow strategy for the provisioning request definition:
Single Flow: This strategy allows one workflow with one recipient.

Flow per member: This strategy allows the recipient to be a group DN. If you
select this strategy, the User Application starts a workflow instance for each
member of the group, and each workflow can be approved or denied separately.
For example, assume there is a provisioning request definition for the recipient
Human Resources. The Human Resource group has the members ablake and
kchester. The User Application passes the Human Resources DN to the
provisioning start. The provisioning interface starts two workflow instances, one
for ablake and one for kchester.

Single Flow Provision Members: This strategy allows the recipient to be a
group DN. If you select this strategy, the User Application starts a single workflow
for the group. The workflow spawns multiple provisioning steps (one for each
member) within the single workflow. The workflow is approved or denied to the
group as a whole, not for each individual member.
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Field Description

Process Type Specifies the type of provisioning request definition. Values are:
Normal: Used for typical workflow definitions that are not related to roles.

Role Approval: Specify this type if the workflow is used for roles approvals.
When this is set, the workflow is available to the Roles Configuration editor and
the SoD Editor. It ensures that the NrfRequest object data item is available in the
data item mapping.

Resource Approval: Specify this type if the workflow is used for resource
approvals. When this is set, the workflow is available to the Resource Editor. It
ensures that the NrfResourceRequest object data item is available in the data
item mapping.

Attestation: Used by Compliance Administrators and Attestation Officers to
submit requests for attestation workflows.

WARNING: ¢ If you change the process type from Role Approval or Resource
Approval to Normal, you must also remove any ECMA expressions related
to the NrfRequest object. ECMA expressions related to the NrfRequest
object are only valid in role based workflows and resource based workflows.
Including these expressions in non-roles-related workflows or non-resource-
related workflows cause runtime errors in the User Application.

* The driver must be Roles Based Provisioning 3.7 or higher.

Notify participants by Specifies whether approvers are notified by e-mail about pending approval tasks,

E-Mail and whether initiators are notified by e-mail of workflow completion. If Notify
participants by email is not selected, then users must look at the Requests and
Approvals tab in the User Application for natifications about tasks.

For information about selecting an e-mail template and customizing e-mail
template parameters, see Section 7.14, “Finish Activity,” on page 260.

Restrict View Specifies that the list of tasks that can be viewed by the user in My Requests in
the User Application is restricted to tasks initiated by the user. The default
behavior (that is, Restrict View is not selected) is that the user can see any
requests that the user initiated or for which the user is the recipient.

Generate Comments Specifies that the workflow engine should generate comments as the workflow
progresses. These comments can be displayed by clicking the following:

+ View Comment and Flow History in a Request Detail form in the User
Application

+ View Comment History in a Task Detail form in the User Application

Set Default Specifies that the default completion status of the provisioning request is
Completion Status to approved if selected, or denied if not selected. This feature can be useful for
Approved provisioning requests that do not contain a provisioning activity (an Entitlement or

Entity). The value of this parameter can be overridden by explicitly setting the
completion status by using a Provisioning activity or Workflow Status activity.

Trustee Rights Specifies the users and groups that can use the provisioning request definition.
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Designer allows you to modify the properties of more than one provisioning request definition at a
time. The provisioning request definitions must be of the same category. You will see a different set
of properties for provisioning request definitions whose categories are Attestations or Roles. See
“Modifying Properties of Attestation or Roles Based Provisioning Request Definitions” on

page 108.

1 With the Provisioning view open, select one or more provisioning request definitions, right-
click, then select Properties. A dialog box like the following displays (the properties you can
modify depend on the type of provisioning request definitions you have selected):

@ Provisioning Request Definition Property Modification

Blank properties have different values for the selected Definitions, Leaving a property blank keeps the original values in
each Definition,
Provisioning Request Definition Details
Cateqgory:
Skatus: | Template w |
Process Type: |N0rmal L3 |
TMotify by Email: |true w |
Restrict: View: |False v |
Generate Comments: |true A4 |
Default Status: |denied v |
Trustee rights: & q_g.‘}
Trustee DN
@ [ Ok ] [ Cancel ]

2 Modify the selected provisioning request definitions as desired by changing the value for that
property.
If you have selected multiple provisioning request definitions and one of the properties does
not contain a value, the corresponding field is blank. If you modify that field, then the value
you specify is applied to all of the selected provisioning request definitions.

3 For Trustees, delete, add, or merge the values for the selected provisioning request definitions.

A merge adds all of the trustees in the selected provisioning request definitions to all of the
selected provisioning request definitions.

4 Click OK to save your changes.
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Modifying Properties of Attestation or Roles Based Provisioning Request Definitions

The provisioning request definitions that support Attestations and Roles cannot be opened in the
Provisioning Request Definition editor so you cannot set their properties by using the Overview tab.
You can set several important properties, such as Trustee Rights, before deploying them.

1 With the Provisioning view open, select one (or more) of the Roles or Attestation provisioning
request definitions, right-click, then select Properties.

@ Provisioning Request Definition Property Modification

Syskem Role property modifications are limited to the setting of trustees only,

Provisioning Request Definition Details

Notify by Email v
Restrict: View: false v

Trustee rights: R {ED‘

Trustee DN

@ oK ] [ Cancel

2 Fill in the fields as follows:

Field Name Description

Notify by E-Mail ~ Specifies whether approvers are notified by e-mail about pending approval
tasks, and whether initiators are notified by e-mail of workflow completion. If
Notify participants by email is not selected, then users must look at the
Requests and Approvals tab in the User Application for notifications about tasks.

For information about selecting an e-mail template and customizing e-mail
template parameters, see Section 7.14, “Finish Activity,” on page 260.

Restrict View Specifies that the list of tasks that can be viewed by the user in My Requests in
the User Application is restricted to tasks initiated by the user. The default
behavior (that is, Restrict View is not selected) is that the user can see any
requests that the user initiated or for which the user is the recipient.

Trustee Rights Specifies the users and groups that can use the provisioning request definition.

3 For Trustees, delete, add, or merge the values for the selected provisioning request definitions.

A merge adds all of the trustees in the selected provisioning request definitions to all of the
selected provisioning request definitions.

4 Click OK to save your changes.
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4.3 Provisioning and Workflow Example

This section describes a common provisioning and workflow scenario. It is designed to help you
understand how the different objects that you create with the provisioning request editor are used by
the User Application.

Suppose a user needs an account on an IT system. To set up the account, the user initiates a request
through the Identity Manager User Application. This request starts a workflow, which coordinates

an approval process. When the necessary approvals have been granted, the request is fulfilled. The
process includes four basic steps:

*

Section 4.3.1, “Step 1: Initiating the Request,” on page 109

*

Section 4.3.2, “Step 2: Approving the Request,” on page 109

*

Section 4.3.3, “Step 3: Fulfilling the Request,” on page 112

*

Section 4.3.4, “Step 4: Completing the Workflow,” on page 113

4.3.1 Step 1: Initiating the Request

In the Identity Manager User Application, the user browses a list of resources by category and
selects one to provision. In the Identity Vault, the selected provisioned resource is associated with a
provisioning request definition. The provisioning request definition is the most prominent object in a
provisioning system. It binds a provisioned resource to a workflow and acts as the means by which
the workflow process is exposed to the end user. The provisioning request definition provides all the
information required to display the initial request form to the user and to start the flow that follows
the initial request.

In this example, the user selects the New Account resource. When the user initiates the request, the
Web application retrieves the initial request form and the description of the associated initial request
data from the Provisioning System, which gets these objects from the provisioning request
definition.

When a provisioning request is initiated, the Provisioning System tracks the initiator and the
recipient. The initiator is the person who made the request. The recipient is the person for whom the
request was made. In some situations, the initiator and the recipient can be the same individual.

Each provisioning request has an operation associated with it. The operation specifies whether the
user wants to grant or revoke the resource.

4.3.2 Step 2: Approving the Request

After the user has initiated the request, the Provisioning System starts the workflow process, which
coordinates the approvals. In this example, two levels of approvals are required, one from the user’s
manager and a second from the manager’s supervisor. If approval is denied by any user in a
workflow, the flow terminates and the request is denied.

Workflows can process approvals sequentially or in parallel. In a sequential workflow, as shown in
the following figure, each approval task must be processed before the next approval task begins.
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Figure 4-2 Sequential Workflow with Two Approvals
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In a parallel workflow, as shown in the following figure, users can work on the approval tasks
simultaneously.

Figure 4-3 Parallel Workflow with Two Approvals
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NOTE: The display labels (First approval, Second approval, and so on) can easily be changed to
suit your application requirements. For parallel flows, you might want to specify labels that do not
imply sequential processing. For example, you might want to assign labels such as One of Three
Parallel Approvals, Two of Three Parallel Approvals, and so on.

The workflow definition is made up of the components shown in the following table:
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Table 4-4 Workflow Definition Components

Process Component Description

Activities An activity is an object that represents a task. An activity can present
information to the user and respond to user interactions. It can also perform
background functions that are not visible to the user.

In a workflow diagram, the activities are represented by boxes.

In the Identity Manager User Application, the activities that handle the
approval process are referred to as tasks. An end user can see the list of
tasks in his or her queue by clicking My Tasks in the My Work group of
actions. To see which workflow activities have been processed for a
particular task, the user can select the task and click the View Comment
History button on the Task Detail form.

To see which workflow activities have been processed for a particular
provisioning request, the user can click My Requests, select the request,
and click the View Comment and Flow History button on the Request Detail
form.

For more information on the My Tasks and My Requests actions, see the
Identity Manager 3.6.1 User Application: User Guide.

Flow paths Flow paths tie the activities in a workflow together. A flow path represents a
path to be followed between two activities.

An activity can have multiple incoming flow paths and multiple outgoing
flow paths. When an activity has more than one outgoing flow path, the flow
path selected often depends on the outcome of the activity. The outcome is
the end result of processing performed by the activity. For example, an
approval activity can have an outcome of approved or denied, depending
on the action taken by the user.

In a workflow diagram, the flow paths are represented by arrows.

Start activity: The workflow process begins with the execution of the Start activity. This activity
displays the initial request form to the user. After the user has provided the initial request data, it
initializes a work document using this data. The Start activity also binds several system values, such
as the initiator and recipient, so that these can be used in script expressions.

Approval activities: After the Start activity finishes, the Workflow System forwards processing to
the first Approval activity in the flow. The Approval activity sends an e-mail to the approver,
notifying this user that his or her attention is needed. When the user claims the task, the Approval
activity displays an approval form, which gives the user the ability to act on the request. In the
workflow examples shown in “Step 2: Approving the Request” on page 109, “First approval” and
“Second approval” are examples of Approval activities. The display labels for Approval activities
can be localized to satisfy international requirements.

An Approval activity has five possible outcomes, each represented by a different flow path exiting
the activity:

* Approved
+ Denied
+ Refused
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* Error
+ Timeout

NOTE: The Error and Timeout outcomes can occur without any action being taken by the user.

If the user approves the request, the workflow follows the approved flow path to the next activity in
the flow. If no further approvals are needed, the resource can be provisioned. If the user denies the
request, the workflow follows the denied flow path to the next activity in the flow. Alternatively, the
user can reassign the task (if he or she is an Organizational Manager or User Application
Administrator), which puts the task in another user’s queue.

The user to whom an Approval activity has been assigned is referred to as the addressee. The
addressee for an activity can be notified of the assigned task via e-mail. To perform the work
associated with the activity, the addressee can click the URL in the e-mail, find the task in the work
list (queue), and claim the task.

The addressee must respond to an Approval activity within a specified amount of time; otherwise,
the activity times out. Typically the timeout interval is expressed in hours or days to allow the user
sufficient time to respond.

When an activity times out, the workflow process might try to complete the activity again,
depending on the escalation count specified for the activity. In some situations, the workflow
process might be configured to escalate an activity that has timed out. In this case, the activity is
reassigned to a new addressee (the user’s manager, for example) to give this user an opportunity to
finish the work of the activity. If the last retry times out, the activity might be marked as approved or
denied, depending on how the workflow was configured.

Log activity: The Log activity is a system activity that writes messages to a log. To log information
about the state of a workflow process, the Workflow System interacts with Novell® Audit. During
the course of its processing, a workflow might log information about various events that have
occurred. Users can use the Novell Audit reporting tools to look at logging data.

Branch and Merge activities: In a workflow that supports parallel processing, the Branch activity
allows two users to act on different areas of the work item in parallel. After the users have completed
their work, the Merge activity synchronizes the incoming branches in the flow.

Condition activity: During the course of execution, a workflow process might perform a test and
check the outcome to see what to do next. The Condition activity provides this capability. Condition
activities use a scripting expression to define the condition to evaluate. In the workflow examples
shown in “Step 2: Approving the Request” on page 109, “Approval Condition” is an example of a
Condition activity.

The Condition activity supports three possible outcomes or exit paths:

+ True
+ False
* Error

4.3.3 Step 3: Fulfilling the Request

When a provisioning request has been approved, the Workflow System can begin the provisioning
step. At this point, control passes back to the Provisioning System.
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To fulfill the provisioning request, the Provisioning System can execute an Identity Manager
entitlement or directly manipulate an Identity Vault object and its attributes. These actions are
performed by either the Entitlement activity or the Entity activity:

+ Entitlement activity: Fulfills the provisioning request by granting or revoking an entitlement.
This activity is not usually executed unless all of the necessary approvals are given.

+ Entity activity: Fulfills the provisioning request by directly manipulating an eDirectory™
object and its attributes. This activity is not normally executed unless all of the necessary
approvals are given.

4.3.4 Step 4. Completing the Workflow

When all other activities have terminated, the workflow executes the Finish activity, which is the
final activity in a workflow. When all the activities in a flow have been completed and the final
result of the flow is available, the Finish activity executes. The Finish activity sends a final e-mail
notification to inform participants of the completion of the workflow.
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Creating Forms for a Provisioning
Request Definition

This section provides details on creating and customizing the User Application’s request and
approval forms. Topics include:

+ Section 5.1, “About Forms,” on page 115

+ Section 5.2, “About the Forms Tab,” on page 118

+ Section 5.3, “Creating Forms,” on page 122

+ Section 5.4, “Action Reference,” on page 131

+ Section 5.5, “Form Control Reference,” on page 134

+ Section 5.6, “Working with Distinguished Names,” on page 173

+ Section 5.7, “Using DAL Queries in Forms,” on page 175

+ Section 5.8, “Printing Forms,” on page 180

+ Section 5.9, “Providing Direct Access to a Form,” on page 180

5.1 About Forms

Forms allow the user to request a resource, approve a resource request, and work on a task. They are
available when the user chooses any of the actions in the My Work category of the User
Application’s Requests and Approvals tab. Forms are also available directly from a URL. For details
on this technique, see Section 5.9, “Providing Direct Access to a Form,” on page 180.

Figure 5-1 is an example of a resource request form. At the top of the form is a read-only area that
displays the details of the request (or approval for approval forms). In the Form Detail section at the
bottom, the user provides input to the resource request (or approval) and takes some action on it.
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Figure 5-1 Sample Form

Novelle Identity Manager fay, | N

Welcome Allion e AL Requests & Approvals i

Ay Work -3

iy Tasks | Request Resource
+ Request Resource Step 3 of 3: Confirm and complete resource request,

Sy ;
I alieers - indicates required.

My Settings - Resource: Title Change Request

Enter Procy Maode Recipient: Allizon Blake

Edit &wailabilit
Nt Availability Resource Category:  Accounts

Ay Proxy Assignments
Description: Allow a user to reguest a title change, Requires manager approval,

Moy Delegate Assignments
Farm Detail

One Step Approval (Timeout Approves)
Press 'Submit' to request the entitlement.

Recipient: Allison Blake

Current Title: il
Requested Mew Title: ‘ |

Reason for request: *‘ |

You use the Forms tab of the provisioning request definition editor to define the appearance and
behavior of the Form Detail section of the User Application’s requests and approvals forms.
About Request Forms

You can create one request form for a provisioning request definition. The request form is associated
with the workflow’s Start Activity.

Figure 5-2 Sample Resource Request Form

Novelle Identity Manager day, June 30, 2006 N
Welc , Al
GRS Idertity Self-Service Requests & Appravals il
Ao Work A
iy Tass | Request Resource
+ Request Resource Step 3 of 3: Confirm and complete resource request,

o ;
I indicates required.

Resource: Title Change Request

¥

My Setkings
Enter Proxy Made Recipient: allison Blake

Edit Awailabilit
e rtdaineg: Resource Category: Accounts

My Proxy fssignments
Dezcription: dllowy a uzer to reguest a title change. Requires manager approval.

Ay Delegate Assignments .
Farm Detail
One Step Approval (Timeout Approves)
Press 'Submit' to request the entitlement.
Recipient: Allizon Blake

Current: Title: =

Requested Mew Title: ‘ |

Reason for request: *‘ |
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About Approval Forms

You can define multiple approval forms for a provisioning request definition, but only one form per
Approval Activity. You can specify the approval form to associate with an approval activity in the
properties for the activity. You can create an approval form via the Forms tab or from the approval
activities property sheet.

Figure 5-3 Sample Resource Approval Form

Ay Requests *-indicates required.

Moy Settings F

Etrar By el Resource: Title Change Request  Recipient:  Allison Blake

Edit fvailability Requested By:  Allison Blake Task: Single Approval

Ay Prosey hssignments InQueue since:  06/30/2006 12:32:18 PAL Timeout on:  03/17/2026 12:32:18 P

My Delegate Assignments . .
hssigned To: ﬁ Marzo Macksnde Claimed By:

Ay Team's Work

»

Team Tasks

Form Detail
Request Team Resources
Team Requests Single Approval

Please select the appropriate button to approve or reject the request.
Ay Team's Settings 3 tllison
N oy — Requested by Allizon Blake Recipient: Blake
Team Delegate Assignments Request Date: O& /3072006

Team Availability Reason:

Current Employee Title:
Requested Title Change:

Comment:

Wigw Comment History

5.1.1 About Form Control Data Binding

All of the fields you define for a form are automatically available for data binding in the Data Item
Mapping property sheet. Two bindings, or mappings, are possible for each form field: a pre-activity
mapping to initialize or pre-load a form field with data, and a post-activity mapping to move
modified form data into the workflow document called flowdata. These data-item bindings, and any
script expressions they use, execute on the application server as preparation of the form before it is
sent to the client browser for display to the user. Common uses for pre-activity data-item mappings
and their expressions that operate against the flow-data document are for moving previous approval
data into the current approval or for setting default values for fields. For more information on data
item mappings, see Section 6.2.2, “Defining the Data Item Mappings,” on page 191.

Some form controls allow you to initialize their values from data sources other than workflow data.
For example, some list controls allow you to specify the initial value as a property of the control. For
more information about defining initial values, see Section 5.5, “Form Control Reference,” on

page 134.

5.1.2 About Forms and Events

Designer allows you to define action scripts that execute on the form control’s onLoad, onChange,
or custom events. Each form control supports an Events property where you supply the script for the
event. The scripts you define have an event-level scope and execute in the browser of the user’s
client machine.
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The Events property provides access to Designer’s Event Action Expression Builder, which allows
you to create script expressions that refer to and modify form and data. Since form control event
scripts execute in the client browser, they do not have access to the flow-data document. They do
have access to directory abstraction layer queries.

Figure 5-4 Event Action Expression Builder

B4 Event Action Expression Builder,

ECMASCript Yariables Functions/Methods ECMASCript Operators
@ Form Methods | "t ECMAScript © math
o Figld Methods @ Relational
o Event Methods @ Logical
o Form Fields @ Skring
o Lists
o ueries
o Script Functions
o Container Methods
I [a]'s ] [ Cancel ] [Check Syntax] [Identitv Vault...]

The Event Action Expression Builder also provides access to the Form Action methods (shown in
the left column). This column provides access to the form action script API along with directory
abstraction layer query objects. The form action script API is written in JavaScript* so that you can
add conditions, loops, and user-defined functions. For more information about the Form Action API,
see Section 9.3.1, “Form Action Script Methods,” on page 331. To import or include a JavaScript
library, you use the Scripts tab of the Form Controls area. For more information, see Section 5.3.4,
“Using the Scripts Tab,” on page 129.

5.2 About the Forms Tab

You use the Forms tab of the provisioning request definition editor to define the appearance and
behavior of your request and approval forms.

118 User Application: Design Guide



Figure 5-5 Forms Tab

® Designar - CallingCard - Dasigner ';E|E|
B ER Yew Project Took Live PRD Window Help
L3= ¢ ; B i £ iy Designes
Torm Selection Farm Contrals
b + H ¥
Form 10 Furm Fiskd Naime: Data Type Control Type Liebreaks
CardRoquest b arng This

Dfficearestode g et

Comelalaters o Picklist
a3 shring Thie

< »
Begquet . Approval Frekde . Auliors | Everis | Sumpts

vervien | Workflom [Foms . Sagnsture Dedarstions

The Forms tab contains a Form Selection section (described in About Form Selection) and a Form
Controls section (described in About Form Controls).

+ Section 5.2.1, “About Form Selection,” on page 119
+ Section 5.2.2, “About Form Controls,” on page 120

5.2.1 About Form Selection

Use the Form Selection section to create, delete, or preview a form, or to create a form template.
Click the Request or Approval tab depending on the type of form you want to manipulate.

Figure 5-6 Form Selection
Form Selection

+ X [H =&

Farm ID
request_form

Request < &pproval

Creating Forms for a Provisioning Request Definition 119



The Form Selection toolbar contains these options:

Table 5-1 Form Selection Toolbar Options

Button Description

Click to launch the New Form Wizard.

LL,J
% Click to delete an existing form.
Click to save the form as a template. You can then base other forms on this template.
L= Forms are saved as XML documents in the project directory.
Templates are available only within the project in which you create them.
Y Click to preview the form.

If you create a provisioning request definition from an existing template, and the template has forms
associated with it, the Form Controls section displays them. You can modify the form instance using
the Form Controls section.

5.2.2 About Form Controls

Use the Form Controls section to define or modify the form’s appearance and behavior.

+ Fields tab: Lets you add, delete, and change the data type, control type, and layout order of the
controls on the form.

Form Controls
+ X ¢ 3

Form Field Name Data Type Control Type Lincbreaks
title: string Title
OfficeareaCade string Text
string Title
Candidates dn PickList
title3 string Title

Fields " actions | Events | Scripts

For information about adding controls, see Section 5.3, “Creating Forms,” on page 122. For
more information about individual form controls, see Section 5.5, “Form Control Reference,”
on page 134.

+ Actions tab: Lets you define the actions the user can perform on the form. Use the Actions
toolbar to add, delete, and change the actions and layout order of the actions on the form.
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Form Controls

& K ’> {L Actions location: | Batkom w

Action Command Linebreaks
iSubmitAckion in
Cancelaction 0

Fields | Artinns - Srrinks

For more information about the supported actions, see Section 5.4, “Action Reference,” on
page 131.

Scripts tab: Use the Scripts tab to define calls to external JavaScript files or to write JavaScript
scripts that are stored as part of the form definition. When you have created a script by using
this tab, it becomes available in the Action Script Expression Builder and you can call it from
any form control event. These scripts have a page-scope rather than an event-scope. For more
information about using the script tab, see Section 5.3.4, “Using the Scripts Tab,” on page 129.

Form Controls
F #H

Id Type URL{Inline Scripk
Scripk inline

< ¥

Fields | Actions | Events | Scripts
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+ Events

Form Controls

Ewent Name Action Expression
onload

< >

Fields | Ackions |Events - Scripts

5.3 Creating Forms

This section describes how to create new forms and add controls to them. It includes these topics:

+ Section 5.3.1, “Creating New Forms,” on page 122

+ Section 5.3.2, “Adding Form Controls and Actions,” on page 123
+ Section 5.3.3, “Defining Events,” on page 125

+ Section 5.3.4, “Using the Scripts Tab,” on page 129

5.3.1 Creating New Forms

1 With the provisioning request definition editor open, click the Forms tab.
2 Inthe Form Selection section of the page, click Add to access the New Form Wizard.

122 User Application: Design Guide



E"}: Mew Form

Form

Form name musk be specified

Form name
|

[ ]create a form using one of the templates

Form kemplates

approval_Form
MoTemplateFarm

Pt
7 Cancel

3 Fill in the fields as follows:

Field Description

Form Name Type the name of the form as you want it to
appear in Designer.

Create a form using one of the templates If you want to base the new form on an existing
template, select this option and select one of the
forms from the Form templates list.

4 Click OK to save the form or click Cancel to exit without saving.

5.3.2 Adding Form Controls and Actions

Use the Form Controls section to define the content and layout of the form.

NOTE: The Designer places form controls on the form from top to bottom and left to right. Use
Linebreaks to force spacing between controls

Creating Forms for a Provisioning Request Definition 123



To add a control to a form:

1 Click Add. Designer adds a control named Field to the bottom line of the form.

If you add more than one control of the same name to the form, Designer adds a unique number
to the end of the control name.

2 Define the following properties for the control:

Field Description

Form Field Name A unique name for the field. The name is used in
+ The Workflow tab’s Data Item Mapping dialog box.
+ The ECMA expression builder dialog box.
+ An internal XML reference in the provisioning request definition file.

Consider the naming conventions you want to use for form fields to avoid
confusion in the Data Item Mapping and ECMA expression builder dialog
boxes. For example, the request and approval forms might both contain a
field called Reason. To make it clear which field you are working with while
performing data mappings, you can preface the field name with the name of
the form where it is used. You might name one reason field Req_Reason and
the other App_Reason.

Data Type The field’s data type. The data type determines the valid control types and the
type of validation performed.

Control Type The type of visual control used to display or edit the data. The selection list is
filtered based on the selected data type.

Linebreaks Defines the number of lines you want inserted after the control.

Form field controls do not have Data Item Mappings or E-mail notifications property sheets.

3 For each control, specify its properties in the Properties tab (available via Window > Show
View > Properties). For more information, see Section 5.5, “Form Control Reference,” on
page 134.

4 Click the Actions tab to define what the user can do with the form. For example, you can add
actions that allow the user to submit a form or cancel it.

A request form must have, at a minimum, a SubmitAction. Without a SubmitAction, the
request will not process. It is recommended that every form also have a CancelAction. Each
approval form must have at least one action defined.

5 In the Actions page, click Add to add a new Action. Fill in the fields 